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PI WebParts is a web-based server product that allows users to create, customize and deploy 
continuously updated views of PI and non-PI data using the Internet Explorer web browser.  

PI WebParts is comprised of single-purpose visual components that can be customized and 
added to web pages. You can: 

• Add and remove web parts from pages 

• Rearrange web parts on a page 

• Modify web part look-and-feel and the display of data 

• Link web parts to PI and other data sources 

• Connect web parts and pass data among them 

PI WebParts are deployed within a framework that includes PI Data Services and SharePoint.  

• PI Data Services provide data to web parts from a variety of data sources, including PI, 
relational databases, and web services.  

• Microsoft SharePoint technologies (page 7) provide user and directory services, web part 
pages, and connectivity between web parts. 

 

About PI 

PI WebParts retrieves and displays data from PI Data Services, which supports connections to 
many different data sources. These data sources will include data from your PI System 
infrastructure and other systems that support different business functions and provide access 
to diverse information.  

You will likely work with PI data stored in:  

AF Server 
An AF Server is a repository of PI System data. It includes at least one logical PI Server or 
collective. An AF Server can contain AF and PI Notifications databases. AF provides a rich 
metadata reference for PI Server data that uses AF Elements and AF Attributes to reference 
tags from a PI Server or data from other non-PI sources.  

PI Module Database objects must be migrated to an AF 2.0 or higher database in order to use 
web part pages containing asset references.  

PI WebParts automatically converts modules, module contexts, aliases and properties to their 
AF equivalent elements and attributes. 

Chapter 1 

Introduction to PI WebParts 
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Note: As of version 3.0, PI WebParts supports AF databases and references, but not PI 
Notifications. 

PI Server 
The PI Server version 3.4.380 and higher introduces a new security scheme and integration 
with AF Servers, which provide a rich metadata layer for PI Server data. AF Elements and 
Attributes can reference PI points as well as data from relational, web service and other 
sources. 

You can reference PI point data directly from the PI Server using tags.  

For individual web parts to display data from PI, you will typically use these items to specify 
the information you want to see: 

AF Attributes 
An AF Attribute is a reference to a data source or stream that is stored in an AF database. An 
attribute can reference a PI Server tag or data from a relational database or other source, 
including non-PI data.  

Only AF Attributes defined as constant values or PI point references are supported in PI 
WebParts. 

Conceptually, an AF Attribute replaces the PI Aliases and PI Properties formerly used in the 
PI Module Database. You can add PI Attributes as Selected Data to a web part along with 
tags, datasets, web part connections or query parameters.   

AF Attributes are children of AF Elements. A key component of an AF Attribute is its 
context path. You can change a context path to allow data from multiple elements to be 
viewed in the same context. See AF 2010 User's Guide for more information about AF. 

A web part treats an attribute as a parameter. The web part resolves the attribute as a value 
only through a query containing the full context path to the attribute. Attribute names are 
displayed in the legend of a web part, while tooltips contain the full path to the attribute in the 
AF database. 

PI Tags 
A PI Server tag is a name reference to a PI point data stream stored in a PI Server archive. A 
PI point represents a single measurement or calculation thereof, and consists of 
value/timestamp pairs and associated attributes.  

Tags may be added as Selected Data to a web part along with attributes, dataset columns, web 
part connections or query parameters.   

In the larger picture, you can think of the functions different types of data perform. In PI 
WebParts, you work with different types of data: 

Time Series Data 
PI Server data is collected and stored in the form of points, each of which represents a time-
series data stream from a particular source, such as a temperature or pressure sensor. A tag is 
a reference name for a PI point.  
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Calculated Data 
Statistical calculations provide another way to view time series data. Averages, High and 
Low values and measures of variance all provide critical information about data events over a 
period of time.    

Contextual Data 
Contextual data is metadata that describes PI points, their properties, and their business use. 
When linked to certain PI WebParts, this information can make data and its presentation more 
logical and accessible to the user community. A PI point tag name is contextual data.  

PI points also have various configurable properties associated with the data stream, called 
point attributes. However, this information is presented largely in language relevant to data 
processing, not in measurements or standard business terms that are easily accessible to users 
outside the IT department. 

Most contextual data for PI resides in AF databases, which can provide a contextual 
representation of all data used in your PI System. AF Attributes can reference PI points and 
attributes or data in other systems, including relational databases and web services.   

 

Client System Requirements 

PI WebParts pages are designed to function as thin clients in a browser window. Most 
processing occurs on the web server to allow minimal client-side system requirements.  

The only absolute requirement for viewing a PI WebParts page is Microsoft Internet Explorer 
(IE) 6 or later with the latest Service Packs. However, certain Web Parts require the following 
additional software installation on client computers: 

Web Part Requires Reason 

PI ActiveView PI ActiveView PI ActiveView 2.2 or higher is required to 
render all features of PI ProcessBook display 
(.pdi) files. Version 3.2 or higher is required to 
display ERDs created in PI ProcessBook 3.2 

PI Gauge 
PI Graphic 
PI Trend 
PI XYPlot 

Adobe SVG Viewer Adobe SVG Viewer version 3.0 is required to 
render web part content in Scalable Vector 
Graphics (SVG) format.  
You can download the viewer from the Adobe 
SVG Viewer 
(http://www.adobe.com/svg/viewer/install) site. 
Note that you must be an Administrator on the 
client machine to successfully install the 
viewer. 

PI ActiveView 
PI Graphic 

PI ProcessBook  PI ProcessBook 3.0 or greater is required to 
use the Launch in PI ProcessBook 
command.  

 PI ProcessBook 3.2 is required to create 
and save element-relative displays using PI 
Attributes. 

http://www.adobe.com/svg/viewer/install�
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Web Part Requires Reason 

PI Messenger  Microsoft Office 2003 or 
higher 

 Outlook XP, or 2003  Address 
Book Control 

 Windows Messenger, 
Windows Live Messenger, 
MSN Messenger, or MS 
Office Communicator 

Office components are required to access 
presence information and select contacts from 
the Outlook Address Book. Either Outlook XP 
or the separately-installed Outlook 2003 
Address Book Control is required.  
One of the specified IM clients is required to 
enable instant messaging from PI Messenger. 

PI BatchTable 
PI Table 
PI TimeSeries 
PI Trend 
PI Values 

Microsoft Excel Microsoft Excel XP or higher is required for the 
Export to Excel > Open function, which 
launches a separate Excel process on the 
client.  
Note that Excel is not required to export web 
part data and save to an .xml file.  

  

Internet Explorer Security Settings 

Internet Explorer security settings prevent the browser from accessing potentially insecure 
sites and applets.  

To set a browser security level in Internet Explorer:  

• Choose Tools > Internet Options and click the Security tab. Then select a web content 
Zone and use the slider to set a security level. 

In general, a Medium browser security setting applied to the Zone associated with your PI 
WebParts server is sufficient.  

If the Medium setting is not permitted for the zone associated with PI WebParts server, you 
can click Custom Level and set each of the following individual settings to Enabled: 

• Run ActiveX controls and plug-ins 

• Script ActiveX controls marked safe for scripting 

• Active Scripting 

• Binary and script behaviors  

• Automatic Prompting for file downloads  

• File download  

• Allow script-initiated windows without size or position constraints (Internet Explorer) 

• Drag and drop or copy and paste files (Internet Explorer 7 and later) 

and the following to Disabled: 

• Use Pop-up Blocker (Internet Explorer 7 and later) 

If necessary, the SharePoint site can be added to the Trusted Sites zone so that custom 
security settings are not applied to other web sites in the same zone. 
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About this Document 

The PI WebParts User Guide is structured in two parts. The initial chapters focus on the 
Windows SharePoint environment used to create web part pages, and general functions that 
apply to all web parts, including web part configuration and SharePoint connections. Later 
chapters cover each of the PI WebParts in turn, and describe the individual functionality and 
features specific to the web part.  

The following are key sections: 

• About PI (page 1) provides an overview of the PI System infrastructure and data used 
with PI Web Parts. 

• PI WebParts Requirements (page 3) describes additional software that may be required 
on client systems using PI WebParts. 

• Working in SharePoint (page 7) explains the basics of creating and navigating web part 
pages in Microsoft SharePoint. 

• Working with Web Parts (page 9) explains how to add web parts to pages. 

• Configure a Web Part (page 17) explains how to customize a web part for use in a page. 

• Connect Web Parts (page 33) explains how to connect web parts to share information. 

• Individual web part sections describe each web part in detail. 

Note: This guide does not include installation or administration information for PI 
WebParts. For installation and administration information, refer to the PI WebParts 
Administrator Guide. For information about configuring data sources for PI 
WebParts, refer to the PI Data Services Administrator Guide. 
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PI WebParts uses the Microsoft SharePoint technologies as a framework for building portal 
sites and web pages with embedded web parts.  

SharePoint is a web-based collaborative architecture that allows users to create customized 
sites and pages that include web parts, documents, links, feeds and other related content. 

Refer to the Release Notes for the specific versions of SharePoint supported. 

Visit the Microsoft SharePoint Products and Technologies 
(http://www.microsoft.com/sharepoint) website for more information about SharePoint. 

 

Configure Your Locale 

The SharePoint locale setting determines the default Windows Short Date and Time formats 
used for SharePoint pages, including web part pages. For example, European locales typically 
use dd-mm-yy short date formats, and Asian locales use yy-mm-dd, while the United 
States uses mm-dd-yy format.  

Generally you can accept and use the default SharePoint Locale (page 8) setting. If 
necessary, you can set a locale for your own user account. Whenever you log on and view 
SharePoint pages, your personal locale is then used to determine appropriate formats.  

To set or verify SharePoint default date and time formats: 

1. In the upper-right corner of the page select My Settings from the menu. 

Your User Information page appears. 

2. Click My Regional Settings to display your Regional Settings page. 

3. Clear the Follow Web Settings checkbox.  

If you leave the box checked, default settings inherited from SharePoint are used to 
determine the locale. 

4. Adjust the Locale, or customize Time Zone, Time Format and other settings on this 
page to match your locale, and click OK. 

Note: If SharePoint Regional Settings conflict with web server or client settings, 
SharePoint's formats override the other formats. The exception is PI ActiveView, 
which interprets time strings (displayed in trend symbols or input through PI 
TimeRange) according to the client time zone setting. If the time zone differs on 
the client computer, PI ActiveView displays a different time context from other web 
parts. 

Chapter 2 

Working in SharePoint 

http://www.microsoft.com/sharepoint�
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SharePoint Regional Settings do not display the Short Date format in use, based on the locale. 
You can look up the same locale in Windows Regional Settings to see the associated Short 
Date format:  

1. If you are unsure of the Short Date format SharePoint is using, choose Start > Control 
Panel > Regional and Language Options. The Windows Regional and Language 
Options dialog appears. 

Note: on Windows Server 2008, the menu path is Start > Control Panel > Clock, 
Language and Region > Change the date, time or number format. 

2. Choose the locale that matches your SharePoint server from the drop menu. The sample 
fields are updated to reflect formats used by Windows for the locale. 

3. Note the Time and Short Date formats. 

4. Click Cancel to exit the dialog box without changing the locale setting. 
 

Configure the Default Locale for a SharePoint Site 

To set the default locale for Microsoft SharePoint: 

1. In SharePoint, choose Site Actions > Site Settings. 

2. Under Site Administration, click Regional Settings to verify or change locale settings. 

You can change the Locale, or customize Time Zone, Time Format and other settings 
on this page, dependent on the locale you select. 
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This section discusses tasks that are common to most PI WebParts. For example, the process 
of adding a web part to a page is the same for all web parts, as is configuring certain format 
and display properties. Similarly, the tool for selecting web part data and the process for 
connecting web parts are the same for all web parts. 

Some tasks and tools that you need when you work with PI WebParts are specific to a 
particular web part. Web part-specific information is covered in corresponding web part 
sections. 

 

Select and Add a Web Part 

A web part page is created by adding web parts to zones on a web part page. You can browse 
available web parts, search for a specific part, or import an existing, saved web part when 
adding web parts to a page.  

To add a web part to a page: 

1. Open a web part page in your web browser. 

2. Click Site Actions > Edit Page.  

3. Click Add a Web Part in the page zone where you want to add a web part. 

4. Scroll through the list of available web parts to find the web parts you want to add to the 
zone.  

5. Select the desired web part. 

6. Click Add to add it to the web part page. 

You can only add one instance of each part at a time.  
 

Export and Import a Web Part 

You can export a customized web part for re-use. Exported web parts are saved in .dwp 
format. 

When you want to use an exported web part on a page, just import the saved .dwp file 
directly to the page. The web part retains any customization made on the original, and you 
can make any additional changes you like.  

Chapter 3 

Working with Web Parts 
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Note: A web part may rely on connections from other web parts that are not present on 
the new web part instance. You may need to change or reconnect these items 
before an imported web part works properly. 

To export a web part: 

1. Click Site Actions > Edit Page.  

2. On the web part that you want to export, click the Edit button > Export.... A File 
Download dialog prompts you to save the exported web part file. 

3. Click Save, specify a directory location, and save the file.  
 

Minimize or Remove a Web Part 

You can close or remove a web part from the page. A closed web part is removed from its 
page zone but remains available as configured. A deleted web part is permanently removed 
from the page zone.  

First enter page edit mode: 

• Click Site Actions > Edit Page.  

To minimize a web part: 

• Click the Edit button > Minimize. Repeat the procedure and choose Restore to return to 
the full-size display.  

To close a web part: 

• Click the Edit button > Close. You can add the configured web part from the Add Web 
Parts dialog box to return it to the display.  

To remove a web part: 

• While in Edit mode, click the Edit button > Delete. The web part is removed from the 
page zone. To restore the web part to the page, you must add it again. 

 

Print Web Parts 

You can print the contents of PI Batch Table, PI Gauge, PI Graphic, PI Table, PI TimeSeries, 
PI Values, PI Trend and PI XYPlot web parts without printing other web part page content. 
To print a web part: 

• Click the arrow at the upper right corner of the web part and choose Print. 

Printing in PI WebParts otherwise relies on Internet Explorer’s print functions. You can print 
an entire page, or print content selected within a web part using the Page Range > Selected 
function in Internet Explorer's Print dialog box.  

You can print trends and SVG views easily from the windows used to display them. The 
Internet Explorer printing add-ins mentioned below are helpful to fit these images to page 
size, but you can also resize the browser window to approximate page dimensions for similar 
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quality. When you are ready to print, press Ctrl-P to set print options (landscape is 
recommended for trends and SVG views) and print the trend or SVG. 

Add-ins 
Fitted/fixed width printing add-ins can improve Internet Explorer printing functionality by 
scaling the image in the browser window to fit the printed page. Add-ins are available on the 
web, and allow you to print directly from the Internet Explorer toolbar. 

Print Screen 
Another option is to use the Print Screen function on your keyboard to save the screen display 
to the clipboard, and then paste the clipboard image into a graphics program that can be used 
to edit, crop or resize the image before printing. You can also copy an ad hoc SVG view 
launched from a web part in the same manner.  

 

Extensions and Related Applications 

You can view and output data using other tools and formats supported by PI WebParts. 
 

Ad Hoc Trends 

Trends help you visualize and provide context to individual data values by tracking the 
behavior of a point value over a period of time. You can create ad hoc trends of data from 
most web parts. Ad hoc Trends update in real time and support many of the same features as 
the PI Trend (page 81) web part.  

You can view trends using menu commands, by clicking in a column with Ad hoc Trend 
behavior in a PI Table web part, or by clicking a data-driven element embedded in a web part, 
such as a value, bar or trend symbol within a PI Graphic display. You can also launch a trend 
in a browser window (page 13) using URL parameters.  

Use one of two methods to display a trend: 

• Click the Edit button > Ad hoc Trend.  

• Right-click inside a web part, and then choose Ad hoc Trend from the context menu.  

Note: Ad hoc Trends can be generated at any time, but are temporary and cannot be 
saved. Use the PI Trend web part to create an embedded trend in a web part 
page.  
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The trend appears in a new window with controls that allow you to scroll the time range and 
scale the trend plot. The time range of the parent web part is used to determine the initial time 
range of the trend plot.  

Use the following controls to customize the trend: 

Time Controls 
Use the following tools to set or adjust the time range: 

• Enter a value in the Start field to specify the start of the time range. Time can be 
expressed in PI time format or the default Windows Short Date and Time format 
configured for SharePoint.  

• Enter a value in the End field to specify the end of the time range. Time can be expressed 
in PI time format or the default Windows Short Date and Time format configured for 
SharePoint. 

• Click Apply to apply updated time values.  

• Click the Revert  button to restore default start and end time values. 

• Click the Scroll Back/Scroll Forward  buttons to adjust Start and End times 
backward or forward by the amount of the current interval duration. If the Start and End 
values are relative times in PI format, scrolling converts the values to absolute times. 
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Display Controls 
Use the following tools to set display options: 

• You can click and drag the mouse in the trend display to zoom in on an area. Click the 
Revert  icon to restore the original view, or right-click and select Undo Zoom from 
the context menu. 

• Click the Data Markers  icon to add plot point data markers to traces. 

• Right-click and select Add Cursor to add a trend cursor, or click the Y axis and drag a 
new cursor into the display. Select Remove All Cursors to clear cursors from the trend. 
Use arrow keys to move a selected cursor left or right in the display. 

Note: Data updates are suspended while cursors appear, or the display is zoomed. 

Data Controls 
Use the following tools to control the data used and how it is displayed: 

• Choose a tag or dataset column from the Tags menu to apply scaling options. 

• Click Hidden to remove a trace selected in the Tags drop-down list from the display, 
cursors, tooltips, and the legend. Restore the trace by clearing the check box.  

• Use Min and Max Scale Range tools to constrain the values scale. 

• Check Multiple Scales to display separate value scales for each trace. 

• Click Apply Scaling to apply scaling changes to the trend. 
 

Open a Trend in a Browser Window 
You can also open an ad hoc trend in a browser window using a URL and parameters that 
specify the Start Time, End Time, and one or more PI tags.  

A single trend is displayed in a separate window with specified PI tags. The trend includes 
the same time, display and data controls that appear in the Ad Hoc Trend Window (page 11).  

A predefined URL is required to launch the trend browser window:  
http://<webserver>/RtWebPartResources/adhoctrendUrl.aspx 

The specific querystring parameters supported are: 

• StartTime - the start time of the trend.  

• EndTime - the end time of the trend.  

• Data - a list of one or more concatenated PI tags or AF Attribute paths in the form: 
\\<PI Server Name>\<Tag Name> or \\<AF Server Name>\<AF 
Database>\<AF Element1-n>|<AF Attribute1-n>  

Note: Both Start and End Times can be in UTC seconds format, or any of the other time 
formats supported by PI WebParts. 
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A PI server must be specified for each tag (relative tag names are not accepted). An AF 
Server and AF Database must be specified for each attribute. Each double backslash 
represents the start of a new tag or Attribute path string. 

All parameter values must be URL-encoded to prevent ambiguity when special characters 
appear in PI tag names or in timestamp values.  

Some examples of valid URL querystrings are: 
http://piwpservername/RtWebPartResources/adhoctrendUrl.aspx?Start
Time=1171852036.9999&EndTime=1171859205&Data=\\piserver\cdt158\\p
iserver\sinusoid 
http://piwpservername/RtWebPartResources/adhoctrendUrl.aspx?Start
Time=02/18/2007%2011:35:44am&EndTime=02/18/2007%201:50pm&Data=\\p
iserver\test%23pound\\piserver2\sinusoid\\Sea%20Temperature 
http://piwpservername/RtWebPartResources/adhoctrendUrl.aspx?Start
Time=Monday&EndTime=Monday%2B1d&Data=\\piserver\test%23pound\\sin
usoid\\piserverw\Sea%20Temperature 

In the above examples, the actual names of two PI Tags are \\piserver\test#pound 
and \\piserver2\Sea Temperature. The tag names are URL-encoded to produce 
parameter values test%23pound and Sea%20Temperature. An end time string 
containing the plus sign (+) is also URL-encoded, resulting in Monday%2B1d. 

Browser-based trends are loaded outside of the context of a SharePoint site, and use local 
web server time zone settings instead of the SharePoint time zone when interpreting and 
formatting Start and End Time values. If invalid parameter values are passed in the 
querystring (for example, unsupported time formats or PI Server or Tag names that are not 
accessible to the web server), an error message is displayed in the resulting trend. If an End 
Time is not provided in the querystring, the present time (*) is assumed. 

 

PI ProcessBook Displays 
You can use either PI ActiveView (page 39) or PI Graphic (page 55) web parts to add PI 
ProcessBook displays to a web part page. There are advantages to each approach: 

• PI ActiveView web parts support ProcessBook displays in native (.pdi) format. 
ProcessBook displays are fully functional in PI ActiveView, but installation of PI 
ActiveView is required on all client computers that view the page. 

• PI Graphic web parts support ProcessBook displays saved in Scalable Vector Graphics 
format as .svg files. This method supports all ProcessBook symbols, but does not support 
ActiveX or VBA components, including symbols such as PI BatchView or the PI SQC 
add-in that may be used in an active ProcessBook display. The Adobe SVG viewer 
(http://www.adobe.com/svg/viewer/install/main.html) must be installed on the client as 
well. 

Generally speaking, the PI ActiveView web part requires more resources on your client 
computer, but allows you to see fully-animated ActiveX controls, Batch symbols, SQC 
symbols, or VBA script components. 

Note: You can also open ProcessBook display (.pdi) or graphic (.svg) files directly in PI 
ProcessBook (page 15) if the application is installed on the local client computer. 

http://www.adobe.com/svg/viewer/install/main.html�
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PI ProcessBook Storage 
PI ProcessBook files for PI Graphic and PI ActiveView can be stored in any network location 
accessible to the SharePoint server. This includes a SharePoint document library, a file 
directory on the SharePoint server, or a network file share users are authorized to access.  

You may want to save .pdi and .svg versions of PI ProcessBook displays where they are 
directly accessible to web part pages, such as a Document Library on the SharePoint server. 
Be sure to copy all graphic files associated with these documents to the same location. See 
the Microsoft SharePoint web site for information on creating and managing Collaborative 
File Stores. 

 

Launch in PI ProcessBook 
PI ProcessBook files can be incorporated into web part pages using PI Graphic and PI 
ActiveView (page 14) web parts. You can also open and edit ProcessBook display (.pdi) or 
graphic (.svg) files directly in PI ProcessBook if ProcessBook is installed on the local client 
computer. If the user has permissions to SharePoint directories (page 15), edits can be saved 
directly to the location where display files are stored, such as SharePoint document libraries.   

To open a display in ProcessBook: 

• When viewing a display in PI ActiveView or PI Graphic, click the Edit button > 
Launch in PI ProcessBook. 

Note: A display file must already be open in the web part in order to launch that file in PI 
ProcessBook. 

 

Export Data to Excel 

Use the Export to Excel command to send data from a web part to a file that can be opened in 
Microsoft Excel.  

You can export data from PI BatchTable, PI Table, PI TimeSeries, PI Trend and PI Values 
web parts to Microsoft Excel. If PI DataLink is installed on the client computer, the results of 
the export can easily be used in DataLink formulas. 

Note: Microsoft Excel is not required on the client computer to save data to Excel file 
format, but is required to open export files in Excel.  

To export data to Microsoft Excel: 

1. Click Site Actions > Edit Page.  

2. Click the Edit button > Export to Excel, and then choose Open to open Excel and 
display the data, or Save to save the data to an .xml file on your computer. 
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When you configure PI WebParts, you supply information used by each web part to acquire 
data. You also determine the time range of data that should be displayed, and how the web 
part behaves and interacts with other web parts. You can also specify custom formatting to 
change the appearance of a web part to better reflect your needs and business purposes.  

To configure a web part: 

1. Click Site Actions > Edit Page.  

2. Click the Edit button > Edit Web Part. The tool pane opens on the right side of the web 
part page.  

To save your changes: 

• Click Apply to apply any changes and reload the web part page, leaving the tool pane 
open. 

Applied changes allow you to review the appearance of the web part in the page and 
make additional changes without closing the tool pane. The changes are saved when you 
click Apply, so using Cancel does not discard them. 

• Click OK to apply any changes and reload the web part page, closing the tool pane.  

Note: You cannot undo changes once they are applied, except by going back to reverse 
each change.  

 

Web Part Tool Panes 

Web parts are configured using the tool pane, which differs depending on the web part. A 
web part tool pane is divided into several tool parts, each representing a category of 
customization settings for the web part.  

Standard tool parts govern the basic display properties of the web part. These tool parts are 
the same for all web parts, even those that are not PI WebParts: 

• Appearance 

• Layout 

• Advanced 

Note: See your Microsoft SharePoint documentation for more information on these 
standard tool parts.  

Chapter 4 

Configure a Web Part 
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The following tool parts are usually the same or very similar for all PI WebParts that use 
them: 

• Time Range (page 18) 

• Selected Data (page 19) 

• Table Columns (page 27) 

Some web parts also have specific tool parts that are not used for other web parts. These 
sections are described under the configuration settings for each individual web part in later 
chapters. 

You can easily modify configuration settings for a web part at any time, and even save your 
changes for re-use in different pages by exporting (page 9) web parts. 

 

Time Range Properties 

The Time Range tool part is common to most PI WebParts, and controls the default time 
range and update frequency for data supplied to the web part.   

If you use PI TimeRange (page 65) to set time ranges implicitly or explicitly for web parts on 
the page, the Start and End Time tool part settings for the web part have no effect. 

 

Times can be expressed using PI time or the Windows Short Date and Time formats 
associated with your SharePoint Web site locale. 

Use the following tools to set the time range: 

• In the Start Time field, enter the start of the time range used by the web part, expressed in 
PI time format or the Windows Short Date and Time format associated with the 
SharePoint Web site locale. The default value is *-2h, or two hours before the present 
time. 

• In the End Time field, enter the end of the time range used by the web part, expressed in 
PI time format or the Windows Short Date and Time format Associated with SharePoint 
Web site locale. The default value is *, or the present time.  

• Click the Connections  button next to a field to create an explicit connection (page 66) 
to another web part, such as a PI TimeRange web part, in order to receive or send time 
range values.  

When an explicit connection is made, the consuming web part no longer receives implicit 
time range changes from the PI TimeRange web parts on the page. Only the explicitly-
connected provider web part affects the time range for the consuming web part. 

• Select update every ## seconds to feed updated data to the web part. Enter a value for 
the number of seconds between requests for updated data. The default value is 15. 
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Note: If you set or scroll a time range using PI TimeRange, data updates may stop. 
Only web parts with an effective End Time of * or *+n (where n is a time 
increment) receive updated data automatically.  

 

Selected Data Properties 

The Selected Data tool part enables you to choose and configure the sources of data used by 
a web part, most commonly AF Attributes, PI tags or datasets.  

 

The Selected Data tool part is common to most PI WebParts, with the following exceptions: 

• The PI Table and PI Messenger web parts provide access to datasets, but not PI tags or 
attributes in the Selected Data tool part.  

• The PI ActiveView, PI Graphic, PI BatchTable, PI TimeRange, and PI TreeView web 
parts do not have Selected Data tool parts.  

You can Add Data Items and specify other properties using the following elements in the 
Selected Data tool part: 

• Selected Data Table (page 24) 

• Replace Ad Hoc Traces (page 25) 

• Parameters and Placeholders (page 25) 
 

Add Data Items 

For most web parts, you can add one or more data items. A data item can be an AF Attribute 
or PI point, specified by name. A data item can also be a relational or web service dataset 
column from a dataset defined in PI Data Services.  

A web part may also receive data items dynamically through a SharePoint connection (or 
querystring (page 35)). Once two web parts are connected, you can add parameters from a 
provider web part as selected data items in the consuming web part.  

Use the controls at the top of the Selected Data tool part to add a new data item: 
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• Click inside a row in the Selected Data table and type the context path (page 26) and 
name of an AF Attribute, or the name of a tag or dataset column. For example, you can 
use the following syntax to specify an attribute : 
\\<AF Server Name>\<AF Database Name>\<Element1-
n>|<Attribute1-n> 

a tag : 

\\<PI Server Name>\<Tag Name> (or simply <TagName>, if from the default 
server) 

or a dataset column : 
<DatasetName>.<ColumnName>  

Press Enter or Tab to validate and add another row. If you click a row and the field is not 
activated for editing, click the corresponding Row Select button  to make the row editable. 
When you select a row containing an AF Attribute name, the context path to the attribute 
appears in the Context Path text box in the Parameters/Placeholders (page 25) section.  

• Click the Select PI Data  button to search for AF Attributes (page 20) or PI tags (page 
21).  

• Click the Dataset Search (page 23)  button to search for available datasets from PI 
calculation, relational or web service sources. 

• Click the Connections (page 34)  button to draw a data item from a connected web 
part on the page, or from a querystring (page 35) in the URL.  

The options available to select data items vary by web part. For example, web parts that do 
not support PI data do not allow you to search for tags. If a data item option does not appear 
in the Selected Data area, it is not applicable to the web part. 

Note: You can use a data item only one time within a single web part, except for the PI 
XYPlot web part, which allows the same data item to serve as both the X tag and 
a Y tag. 

 

Attribute Search 

Most PI WebParts can display data from the PI Server or other sources by referencing AF 
Attributes. An attribute search allows you to pick an AF Server and database, search for 
attributes, and add those you need to the Selected Data list. 

To add attributes to a web part: 

1. In the Selected Data tool part, click the Select PI Data  button. The Select PI Data 
dialog opens. 

2. On the Attribute Search tab, choose an AF Server from the list of available Servers. 

3. Choose an AF database from the list of Databases within the selected AF Server.  
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4. Navigate through the tree by clicking to expand nodes.  

AF Element nodes are parents to AF Attributes  in the server.  

5. Select attributes to add them as Selected Data sources.  

The paths to and names of selected attributes appear in the Attribute panel below the tree.   

6. Click OK to save the attribute selection to your Selected Data list. 
 

Tag Search 

Most PI WebParts can display data from the PI Server in the form of tags. A tag search 
allows you to pick a PI Server, search its list of tags, and add those you need to the Selected 
Data list. 

To add tags to a web part: 

1. In the Selected Data tool part, click the Select PI Data  button. The Tag Search 
dialog opens. 

2. On the Tag Search tab, choose a server from the PI Server list. 

3. Type the name of the tag into the Name mask field.  
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4. If you don't know the exact name, you can use a wildcard character in a name mask. Use 
an asterisk (*) for multiple characters, or a question mark (?) for a single character.  For 
example, to find tag names that start with the letter "C" you can type in: C*. 

 

5. Click the Search button. The Tag Search dialog box queries the specified server for tags 
that match the name mask, and displays them in a list.  

6. Click a tag to select it in the Search Results list, and click Add to add it to the selected 
tags panel. Select and add multiple tags by holding down the Ctrl or Shift key while you 
click to select.  

Select a tag and click Remove to remove it from the selected tags panel.  Click Clear List 
to remove all selected tags.  

7. Click OK to add the tags to your Selected Data list. 

You can also search for tags based on criteria other than tag name. Click the More… link at 
the top of the Tag Search dialog to search using different tag attributes. You can specify as 
many criteria as you want, with each selection narrowing the search to the list of tags that 
meet all the search criteria. Use the paging buttons at bottom to move through search results. 
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Dataset Search 

Many PI WebParts can also display data from datasets configured in PI Data Services. 
Examples of a dataset are a PI Calculation dataset, a query to a relational database, a web 
service method, or a Microsoft Excel spreadsheet. 

Generally, you use a single dataset column as a web part data item. A column is analogous to 
PI point values in the sense that one dimension of data is represented. Additional columns can 
be added as Selected Data items. The PI Table web part is an exception (page 24) in that you 
add all the columns in a dataset at once.  

If you want to use a dataset with web parts that typically display current or historical PI data, 
your dataset should include both data and a date or timestamp column that forms a time series 
(page 99). Datasets are the only type of data item available to PI Messenger and PI Table web 
parts. 

To add a dataset column to a web part: 

1. In the Selected Data tool part, click the Dataset Search  button. The Datasets dialog 
opens. 

2. Click to select a dataset you want to use. A list of available columns for the dataset 
appears in the column pane below. 

 

3. Select the column you want to add. Hold down the CTRL or SHIFT key while clicking to 
select multiple columns. 

4. Click OK to add the selected column or columns to the Selected Data list. 
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5. If applicable, enter parameters and placeholders (page 25) to configure additional 
information for the dataset column.  

 

PI Table and PI Messenger Dataset Search 
For the PI Table and PI Messenger web parts, the dataset search dialog does not prompt you 
to choose a column associated with a selected dataset. Instead, you choose a dataset, and then 
configure PI Table (page 63) or configure PI Messenger (page 71) to display only the 
columns you want to appear in the table. 

 

Each PI Table web part displays columns from a single dataset. If you add another dataset, it 
replaces the first. Add additional PI Table web parts to show columns from different datasets. 

 

Selected Data Table 

The Selected Data table lists all data items assigned to the web part. You can use the table to 
manage the data items. You can also select a data item to format corresponding data in the 
web part using other sections in the tool pane.  

Manage the list of data items using these tools: 

• Click the attribute icon to the left of an attribute name to select it.  

When selected, the path to the selected attribute appears in the Context Path text box in 
the Parameters/Placeholders section. 

• Click the tag icon  to the left of a tag to select it. 

• Remove the selected item using the Delete  button.  

• Remove all items, including web part connections, using the Clear  button.  

Data items appear in the Selected Data list in the order they are added, and this same order is 
preserved within the web part display. You can change the position of the selected item in the 
list using the Up  or Down  buttons.  
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Replace Ad Hoc Traces 

The Replace Ad Hoc Traces check box appears for PI Trend and PI XYPlot web parts.  

Keep this box checked to enforce the default substitutive behavior of web part connections, 
where data sent from connected web parts replaces data traces previously sent to a trend or 
XY plot. A trace drawn from a new connection event replaces the trace drawn from the 
previous connection event. 

When deselected, behavior becomes cumulative, and new traces are added to those sent by 
previous web part connection events. 

Ad hoc traces are lost if you navigate away from the page, enter or exit Design mode, or close 
the browser window. 

Note: Additive behavior works only when the web part page is fully in Run mode. In Edit 
mode, ad hoc traces are replaced regardless of the setting.  

 

Parameters/Placeholders 

The Parameters/Placeholders group appears when an AF Attribute or a relational or web 
service dataset with parameters or placeholders is selected within the Selected Data list. 

For AF Attributes, a parameter/placeholder is a context path (page 26) that relates the 
attribute to a parent AF Element in an AF database. For datasets, a parameter/placeholder 
represents a placeholder in a SQL query or a parameter passed to a web service method. 

  

Note: Parameters and placeholders are not available for PI tag data items. 

Each parameter or placeholder item configured for a selected dataset appears, paired with a 
value field. If a display name has been configured by the dataset designer, the display name is 
shown instead of the default name.  

To specify placeholder or parameter values: 

• The initial value for each parameter or placeholder is a default value specified by the 
dataset creator. You can accept the default value or enter a new value for any item.  

• Click the Connections  button to accept parameter and placeholder values from a 
connected web part on the page. 
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Context Paths 
A context path relates an AF Attribute to a parent element within an AF database. An AF 
Attribute added as a web part data item can point to different underlying PI points, depending 
on its context path.   

Context paths can be used to drive displays created in PI WebParts and other PI client 
applications. Displays that utilize context paths in this manner are referred to as element-
relative because the data displayed for the attribute at any time depends on the context path 
that links the attribute to a parent element. 

Context Path Example 
Context paths are used most frequently to change the data displayed by a web part based on 
user selection. For example, based on the selection of AF Elements or attributes that represent 
assets in a plant, a display may present data from parallel assets in a single plant or in 
different locations. A provider web part can pass a context path to a consumer web part 
through a SharePoint connection, allowing one web part to dictate the data displayed in 
another. 

For example, assume Tanks 1-5 in a plant are all described by the same measurement 
attributes of temperature and pressure. Each tank is represented as an element in the AF 
database with corresponding temperature and pressure attributes. A web part display (or any 
other PI client display) that references the temperature attribute could display data for each 
tank in turn by allowing the user to specify the context path to any particular tank element.   

In PI WebParts, context paths are sent most frequently from the PI TreeView web part, which 
provides hierarchical browsing of AF database. PI TreeView can act as a context path 
selection tool in a web part page. When you click a node in the tree, the corresponding path is 
sent to connected web parts. Context paths are most commonly sent to PI ActiveView and PI 
Graphic parts to override a default context path (page 59) stored in a display. 

To use context paths with PI Attributes selected as data: 

1. In Design mode, create a SharePoint connection (page 33) between the provider and 
consumer web parts. 

2. Modify (page 17) the consumer web part and display the tool panel. 

3. In the Selected Data tool part, use an attribute search (page 20) to locate and add the 
desired attributes as data items. 

When an attribute is selected in the Selected Data table, a Context Path field appears in 
the Parameters/Placeholders (page 25) area. 

4. Click the Connections  button next to the Context Path field and choose the 
ContextPath connection field (page 34) from the provider web part to establish a 
SharePoint connection, and then click OK. 

Note: Each attribute selected has its own separately configured context path.  

The Connections icon turns green  to indicate a live connection. The consumer web 
part updates to reflect attribute data associated with the selected context. 
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5. In the provider web part, choose a new element or attribute to test the connection. The 
consumer web part is updated with new data based on the context path if an attribute with 
the same name is a selected data item.  

 

Table Column Properties 

The Table Columns tool part is used to specify data and formatting for web parts that use a 
tabular display format, including PI Table, PI TimeSeries, and PI Values. 

 

Several features in the table columns tool part are used to format the display: 

Available Columns 
A list of dataset columns that can be added to the table. Select columns and use the down 
arrow button  (right) to move them to the Selected Columns box to display them in the 
table.  

Columns configured in the dataset as Hidden appear in the available columns list by default. 
All other columns appear in the Selected Columns list by default. 

Selected Columns 
A list of dataset columns selected for display in the table. You can remove selected columns 
from the table by clicking the up arrow button  (left) to move them into the Available 
Columns list. 

Any columns not configured as Hidden in the dataset are selected by default. 

The Up and Down arrow buttons at the bottom right of the Selected Columns list are used to 
control the order of the columns in the list. The order from top to bottom in the list 
determines the order of appearance, left to right, in the web part. 
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Rows to Display 
The maximum number of rows visible at any one time in the table. If more rows of data are 
available, paging buttons  on the table allow the user scroll through 
additional rows. 

Automatically Provide First Row 
Select Automatically Provide First Row to specify that a PI BatchTable web part 
automatically provide the first result row returned by a batch search to connected web parts. 
This appears for PI BatchView web parts only. 

 

Behavior Settings 

While most dataset column values may appear as simple data points, others may provide 
graphic, descriptive, or linking features. For example, you can click on hyperlinked data 
values to send data through a web part connection, launch pages in a browser, or show a 
trend. 

You can format PI Table, PI TimeSeries and PI Values columns using table format 
configurations. A configuration determines the appearance and click-actions of cell data by 
mapping tags or dataset columns to specific behaviors.  

Apply table configurations as Behavior settings:  

• Select a table configuration from the Behavior Settings list.  

Two table configurations are included with PI WebParts. The RtSnapshot Table 
configuration is applied automatically to PI Values web parts, and RtArchive Table 
to PI TimeSeries web parts.  

Configurations are listed in alphabetical order, with the first applicable configuration 
applied to a PI Table dataset by default. If no configuration is associated with the selected 
dataset, Behavior Settings is set to None (which may also be selected to revert to the 
default configuration). 

• If you are a PI WebParts Administrator, click the Configure  button to edit or add 
new configurations. A PI WebParts Configuration page opens in a new browser window.  

See the PI WebParts Administrator Guide for more information about table 
configurations. 

The following column behaviors may appear in table configurations: 

Trend 
Columns with Ad hoc Trend behavior display column data as hyperlinks; when clicked, each 
link opens a Trend graph in a separate browser window using the tag name configured for 
that row. 
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Current State 
A column set to Current State behavior compares the column value to reference values with 
a deviation indicator.  

 
The indicator shows how far the column value lies above (to the right) or below (to the left) a 
typical reference value. If a column value exceeds or drops below the maximum or minimum 
reference values, the indicator blinks. 

Minimum, maximum, and typical values can be determined by the zero, zero + span, and 
typical value attributes of the underlying tag, or drawn from other columns in the dataset.  

Current State behavior can be used only for numeric or digital state data points with good 
status. An indicator is not displayed for a row with bad status or incorrect configuration, and 
the table cell displays a Warning icon. Place the cursor over the icon to see a brief error 
message, or click the icon to view full information about the problem.  

Hidden 
Columns set to Hidden behavior can be used to provide data to other web parts through a 
connection, but are not displayed in the table by default. 

Hidden configuration sets the default position of the column (placing it in the Available 
rather than the Selected columns list). Hidden columns can still be displayed, but by default 
they are not. 

Hyperlink 
A column set to Hyperlink behavior appears as a hyperlink to a web page, web image file 
(for example, GIF or JPEG), or other file (for example, SVG or PDI). The hyperlink URL can 
be fixed, or can consist in whole or in part of the value in another column in the dataset, 
regardless of whether or not that other column is displayed.  

Hyperlink behavior columns include an icon in the column heading, or replace individual 
column values with icons, depending on the configuration. When an icon or link is clicked, 
the target URL may be opened in the current window, a new browser window, or a modal 
dialog box window. Row data may also be sent to connected web parts, instead of navigating 
to a URL.   

When a cursor hovers over a column hyperlink, a ToolTip appears to indicate the link 
destination. The ToolTip text is also configurable by an administrator under PI Table 
Behavior Configuration settings. 

Conditional Formatting 
Tables may also have both default and conditional formatting applied to cells based on format 
behaviors configured by an administrator.  

Conditional formatting highlights extreme or suspect values on a conditional basis. Each cell 
can be evaluated on an individual basis and new formatting applied if the value satisfies a 
preset condition expression. Multiple conditional formats can be specified for each column, 
and are evaluated in the order in which they are defined until an applicable condition is 
found.  
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Filter Data 

A Filter Value specifies a data element associated with a web part, whose corresponding data 
values may be sent to another web part in order to filter or select data results.  

For example, a filter value would commonly specify a parameter or data column in a web 
part. When a web part connection is made, corresponding data values are sent to the 
consumer web part. The consumer may receive a PI tag name, a Start Time, a module context 
or another type of parameter used to query or delimit a dataset.  

In PI WebParts, filter values are used mainly for connections with the Microsoft Excel Web 
Access web part (page 36). The resulting values can be used to resolve PI DataLink functions 
and retrieve data from PI. Filter values can also be sent to any SharePoint web parts that 
support filter values connections. 

The Filter Value tool part appears in the tool pane for these web parts: 

PI BatchTable Filter Values 
In PI BatchTable, use Filter Values to specify a batch table column. A data value from the 
specified column is sent when a corresponding table row is selected.  

PI Table Filter Values 
In PI Table, use Filter Values to specify a table column. A data value from the specified 
column is sent when a corresponding table row is clicked. Underlying column data is sent if 
the column displays something other than the data value, such as a link or graphic. 

PI TimeRange Filter Values 
In PI TimeRange, Filter Values indicates the type and format of time strings sent through 
web part connections.  

By default, PI TimeRange sends Time Range, Current Time, Start Time and End Time 
parameters in PI Time (page 97) format. These values can also be sent in two alternate 
formats (page 67) through web part connections:  

ο (Localized) versions of time parameters use default Short Date and Time formats 
specified for the locale (page 7) of the SharePoint site.  

ο UTF versions of time parameters use Universal Time Format (page 67) strings. 

You can also specify the IsUpdating flag as a filter value to indicate when the web parts 
cache is updating with new data. 

These alternate formats are useful for connections to 3rd party web parts that require time 
strings in Windows-based formats, and those that do not work with localized formats, such as 
the Excel Web Access web part.  

Note: Filter values for PI TimeRange do not necessarily correspond to a click event to 
send information to another web part. They affect all web part connections 
associated with a particular instance of PI TimeRange, including implicit 
connections. 
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PI TimeSeries Filter Values 
In PI TimeSeries, use Filter Values to specify a table column. A data value from the 
specified column is sent when a corresponding table row is clicked.  

You can specify date and time-formatted column data be sent in PI Time (page 97) format 
(default), or using locale-specific (Localized) and Universal Time Format (UTF) versions, as 
in PI TimeRange web parts. 

PI TreeView Filters 
In PI TreeView, use Filter Values to select a tree element to send through a web part 
connection. You can send any of the following as a filter value: 

ο PI tag list 
ο AF Element name 
ο AF Element path 
ο Element-relative context path (page 26) 
ο AF Attributes specified in any attribute parents 

PI Values Filters 
In PI Values, use Filter Values to specify a table column. A data value from the specified 
column is sent when a corresponding table row is clicked.  

You can specify date and time-formatted column data be sent in PI Time (page 97) format 
(default), or using locale-specific (Localized) and Universal Time Format (UTF) versions, as 
in PI TimeRange web parts. 
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When two web parts on a page are connected through a SharePoint Connection, content 
displayed in one web part updates based on a selection or click event within the other. One of 
the most useful features of PI WebParts is the interoperability that allows you to connect web 
parts to create interactive displays. 

For example, you can select an AF Attribute from a PI TreeView web part and add 
corresponding traces to the display in a PI Trend web part. You can also pass time range 
parameters from one web part to others.  

Note: Data supplied through a web part connection remains when the page is refreshed, 
but is lost if you navigate away from the page or close the browser window.  

In addition, you can define connections not only between PI WebParts, but also between PI 
WebParts and third-party SharePoint web parts. For example, you can input data for SQL 
query placeholders in a Microsoft Form web part and use them to update a PI Table web part. 
You can send parameters from a PI TimeRange web part and use them to update a 
spreadsheet in the Microsoft Excel Web Access web part. 

Each web part connection may be one of three types, and requires a provider web part and a 
consumer web part: 

• Web parts that send information to others are providers. 

• Web parts that receive information from others are consumers. 

• Some web parts can be both providers and consumers at the same time. 

With the exception of PI TimeRange, which can automatically connect (page 66) to other 
web parts on a page, you must explicitly create SharePoint connections. Connecting one web 
part to another is a two-step process:  

• First, establish a SharePoint connection (page 33) between provider and consumer web 
parts on the page. 

• Then modify the consumer web part using the Connections dialog box to configure 
parameters (page 34) for each connection. 

 

Establish a SharePoint Connection 

To connect web parts, first establish a SharePoint connection that defines a provider and 
consumer for the exchange of information.  

To connect web parts: 

Chapter 5 

Connect Web Parts 
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1. Open a web part page in your web browser. The page should have two or more web parts 
in order to support a connection. 

2. Click Site Actions > Edit Page.  

3. On either of the participating web parts, click Edit > Connections > connection type > 
web part. 

4. Choose a connection type from the first submenu.  

The options available depend on the consumer and provider web parts, and more than one 
connection type may be available.   

Client-side (Parameter) and Server-side (Row) connections pass the same data. To minimize 
server round-trips (post-backs), use client-side connections when available. Some 
connections, particularly those between PI WebParts and the Excel Web Access web part, use 
filter (page 36) connections. 

If the web part can transmit filter values (page 30) as well, you may be prompted to confirm 
that you are sending a client or server parameter instead of a filter value.  

To indicate that the two web parts are connected, a check mark now appears in each web 
part's Connections menu.  

With the SharePoint connection established, you can now define which information you want 
the consumer web part to accept from the provider.  

 

Specify Connection Parameters 

If a web part can act as a consumer, the Connections  button appears next to any data 
fields in the web part's tool pane that can be populated by another web part via a SharePoint 
connection. 

1. Click a Connections  button next to the field that you want to update from a provider 
web part. The Connections dialog box opens. 

2. The Connected Web Parts list displays web parts connected as providers. If no web 
parts appear in the list, there are no web parts connected as providers. Click cancel and 
establish a SharePoint connection (page 33) from the provider web part before 
continuing. 

3. Select a provider web part from the Connected Web Parts list. The Connection field 
displays a list of all data columns available from the provider. 
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4. Select a data item and click OK to complete the connection.  

You can also select None to remove a mapping to a particular data item without breaking 
the web part connection. 

The Connections button turns green  when configuration is complete, indicating that 
the data field is populated by a provider web part on the page. 

Note: Only one data item may be passed through a SharePoint connection to a given 
field. If a new connection is specified, the previous connection is replaced.  

Once a connection is complete, you can trigger the connection from the provider web part in 
order to view data updates in the consumer web part. For example, click an Attribute in the PI 
TreeView provider web part to send information to a connected PI Trend web part 
established as a consumer. 

 

Querystring Parameters 

Querystring parameters can be added to a web part page URL to send parameter connection 
values to consuming web part fields when the page first loads. Querystring parameters may 
be established for any web part field which accepts a SharePoint connection as a data source. 
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Note: A querystring parameter overrides the default value of the field, and in turn is 
overridden by any connection parameter sent from another web part. 

For example, consider a page with the URL 
http://webserver/Shared Documents/mypage.aspx 

that contains a PI Trend web part. The Start Time and End Time fields are assigned the 
querystring parameters start and end, respectively. The trend is also configured to show the 
value of an AF Attribute, which exists under various element contexts. The Context Path 
field for the web part is configured to get its value from a querystring parameter 
contextpath. 

A user who wants the page to initially display a trace of the AF Attribute residing under 
\\PISystem\AFDatabase\MyElement over the past four hours would add the 
querystring parameters and values to the web part page URL as follows: 

http://webserver/Shared 
Documents/mypage.aspx?contextpath=\\PISystem\AFDataBase\<Element&
start=*-4h&end=* 

where parameter-value pairs are delimited with the ampersand character (&), or its URL 
encoding. 

To set a querystring parameter for a consumer web part: 

1. In the Selected Data tool part, click a Connections  button next to the field that you 
want to update through a querystring parameter. The Connections dialog box opens. 

2. Enter the desired querystring parameter name in the Querystring parameter for default 
field and click OK.  

  
 

Excel Web Access Connections 

The Microsoft Excel Web Access (EWA) web part is included with the Enterprise Edition of 
Microsoft SharePoint Server 2007 (MOSS). You can add this web part to a page and connect 
it to PI WebParts as a consumer. 

Typically, Excel workbooks published in SharePoint for use with PI WebParts include PI 
DataLink or PI BatchView functions that are supported by PI DataLink for Excel Services, a 
server version of the PI DataLink Add-in for Excel.  
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For more information about the EWA web part, PI DataLink for Excel, and integration with 
PI WebParts, consult the PI DataLink for Excel Services Guide. 

You can send three types of data from PI WebParts to EWA: 

• Workbook names, to display a particular workbook in an EWA web part. 

• Named items, such as a range, chart or pivot table name, to view only that element in the 
EWA web part. 

• Cell parameters, to input a value to a spreadsheet cell, which in turn may be referenced 
by a PI DataLink function. 

Note: Workbook names and named items are sent through client or server-side 
connections (page 33). Cell parameters are sent through an IFilterValues 
connection. 

To send filter values through a web part connection: 

1. Configure the Filter Values (page 30) property of the provider web part. 

2. From either of the participating web parts, click Edit >Connections > filter connection > 
second webpart for connection.  

The connection options available depend on the consumer and provider web parts, and 
whether you initiate the connection from the provider or the consumer.  

A workbook with named cells must already be loaded in the EWA web part to complete a 
FilterValues connection. However, you can send a workbook URL name or Named Item 
to an empty EWA web part.  

To indicate that the two web parts are connected, a check mark now appears in each web 
part's Connections menu. The Configure Connection dialog box appears. 

3. If your connection began from the provider web part, specify the Connection Type on 
the Choose Connection tab, and then click Configure. 

 

4. On the Configure Connection tab, select the parameter item in the Filtered Parameter 
menu that you want to specify through the web part connection. 
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For EWA connections, Filtered Parameter values correspond to named cells in the 
Excel workbook. 

5. Click Finish to complete the connection. 

If the consumer web part is an EWA web part, the workbook recalculates automatically 
on receipt of the parameter, allowing PI DataLink functions to access the PI server and 
refresh cell values in the spreadsheet. 

 

Remove Connections 

You can sever connections between web parts if you want to redirect them to new providers 
or consumers. 

To remove connections: 

1. Click Site Actions > Edit Page.  

2. On either web part that you want to disconnect, click Web Part Menu > Connections. 
Check marks appear next to listed web parts to indicate active connections to the current 
web part. 

3. Select the web part you want to disconnect. You are prompted to confirm the removal of 
the connection.  

4. Click OK to disconnect the web parts. 
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The PI ActiveView web part displays PI ProcessBook displays on a web part page. The PI 
ActiveView web part is closely linked to two other PI client applications:  

• PI ProcessBook is used to create ProcessBook display (.pdi) files viewed in PI 
ActiveView. All the graphic elements in a ProcessBook display are configured in PI 
ProcessBook.  

• ProcessBook displays are rendered in PI ActiveView using the PI ActiveView 
application. PI ActiveView comprises a client-side executable, an ActiveX control, and 
other tools for developing and deploying web page applications. 

 
The PI ActiveView web part supports both static and dynamic ProcessBook content. Displays 
appear as they do in PI ProcessBook, but are view-only. The PI ActiveView web part also 
supports any configured PI data, PI Calculation dataset and ODBC dataset used by a 
ProcessBook display, provided connection settings to non-PI data are configured on the client 
computer to show updated data.  

 

Chapter 6 

The PI ActiveView Web Part 
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PI ActiveView Refresh Rate 

The PI ActiveView web part uses the PI ActiveView application to manage data updates to 
ProcessBook displays. When dynamic data elements in a display are configured to update, PI 
ActiveView queries the PI server and receives new values. The new data is used to extend 
trend traces, update display values, and refresh any other symbols that indicate current values 
or status.  

PI ActiveView has a default polling rate of 5 seconds, meaning that PI ActiveView contacts 
the PI server every 5 seconds looking for new data to update the display. You can configure 
this setting to change the polling rate using PI ActiveView settings stored in the 
PIPC\dat\Acview.ini file on the client computer.  

• Adjust the Timer value in the Data Manager section to reset the polling rate. The default 
value is 5000 milliseconds, and the maximum value is 60000 milliseconds.  

 

Configure PI ActiveView Web Parts 

You can configure a PI ActiveView web part using the web part tool pane and standard 
configuration tool parts including Time Range (page 18), Appearance, Layout, and 
Advanced. 

The PI ActiveView web part also includes three additional tool parts that allow you to specify 
how the ProcessBook display appears in the web part. 

 

PI ActiveView Configuration 

The ActiveView Configuration tool part specifies the display contents for the web part. Use 
the Selected File field to indicate the .pdi file you want to show in the PI ActiveView web 
part. 

You can enter a full path to a file, or enter a partial path and click the downward arrow to 
Browse or Search for a file.  

The path may use a UNC path to a file share, such as 
\\servername\directory\file.pdi  

or an absolute URL such as 
http://myserver/directory/file.pdi 

You can also click the Connections  button to receive a file path through a web part 
connection. 
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Current Context Path 

The Current Context Path tool part allows you to manage the context (page 26) of PI 
ProcessBook displays (.pdi or .svg) in PI ActiveView and PI Graphic web parts. Context 
paths operate as parameters you can use to dynamically present different PI data in the same 
file display. 

Since PI WebParts 3.0, element-relative displays largely replace module-relative displays 
(that support PI Aliases from the PI Module Database) used in earlier versions. 

The PI ActiveView web part loads a ProcessBook .pdi in the PI ActiveView control on your 
computer. If PI ActiveView 3.2 is installed and the module relative display (MRD) add-in is 
removed, PI ActiveView converts the MRD to an ERD. If the MRD add-in remains installed 
for ActiveView, the .pdi is not converted to an ERD. 

PI TreeView sends AF context paths and not module contexts. Pre-existing PI TreeView web 
parts used to supply module paths will not drive displays that rely on module contexts. You 
can continue to use other web parts (such as PI Table or a third-party WP) to send module 
paths. 

The last context (or module) path selected when the display file was saved in PI ProcessBook 
becomes the default context. Once a PI ProcessBook display file is referenced by a web part, 
use the Override Default Context Path field to define a new default context when the file is 
loaded in the web part. You can also send context paths to the web part from provider web 
parts. 

To override a default context path: 

• In PI ActiveView, click the Select Default Context button to select a new context path 
from the AF database using the Select Default Context dialog.  

• You can also use the Connections  button to drive the element context for PI 
ActiveView through other web parts on the page. 

For example, to create a display that allows you to toggle between attributes under Unit 1 
and Unit 2 elements (and show corresponding data for each), you can connect a PI 
TreeView web part to a PI ActiveView web part and send a context path. 

The target web part displays a .pdi display configured to use the same named attributes. 
Map the relative path parameter from the PI TreeView to the Context Path field on the PI 
ActiveView web part. 

Once configured, click on the Unit 2 module in PI TreeView when you want to see data 
from Unit 2 instead of Unit 1, and vice versa. 
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PI ActiveView Settings 

The Settings tool part provides the means for automatic download and update of the PI 
ActiveView application to client computers using the HTML code-base attribute.   

Clients can automatically update the PI ActiveView application when new versions are 
posted in the code base location, and ensure that the PI ActiveView application is installed 
when the web part is used. 

For PI ActiveView 3.0 or later enter the full path to the setup kit (ActiveView_3.x.x.x_.exe) 
in the ActiveViewcodebase field. For earlier versions, enter the path to the PI ActiveView 
cab file (acviewinf.cab). 

The path may be a UNC path to a file share, such as: 
\\servername\directory\acviewinf.cab 

or an absolute URL such as 
http://myserver/directory/ActiveView_3.1.0.2_.exe  

 

PI ActiveView Connections 

The PI ActiveView web part supports SharePoint connections (page 33) to other PI 
WebParts: 

As a Consumer 
• Accepts time range changes from the PI TimeRange web part, or any other web part that 

provides Start and End timestamps. 

• Accepts .pdi filenames from any web part that can provide a file path. 

• Accepts querystring parameters to set initial values. 
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The PI BatchTable web part provides a means to search for PI batch information and 
exchange batch data with other web parts.  

Batch searches can be configured to execute automatically on loading a page, or run with 
parameters supplied to the PI BatchTable web part or consumed from other web parts.  

 
A successful batch search returns a list of batches that match the search criteria. Selecting a 
batch in the table can pass batch data to connected web parts.  

Note: The PI BatchTable web part relies on the PI OLEDB provider to retrieve PI Batch 
data through PI Data Services. The PI OLEDB Provider is provided for use with PI 
BatchTable only, and is not licensed for any other purpose. 

 

Chapter 7 

The PI BatchTable Web Part 
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Batch Searches 
Define a batch query by building an attribute mask of search criteria to describe the batches 
you want to see; batches that fit the criteria are displayed in the batch table once the search is 
run.  

To define a batch query: 

1. Choose a Batch Type to search for in the PI Batch database. Only batches of the 
specified type are returned by the search. 

2. Specify the name of the PI Server containing the target PI Batch Database.   

3. Specify the Status of batches to be returned: 

ο Choose Running to return only batches that are currently running. 
ο Choose Completed to return only batches that have an end time. 
ο Choose Both to return all matching batches, whether running or completed.  

4. Enter start and end times to define a time range for the search.   

You can enter relative PI times or use the calendar button to enter fixed times. 

5. Specify each batch attribute you want to define to limit your search in the Attribute 
Masks section.  

Only batches matching all search criteria (page 45) are returned. This section may 
contain different attribute mask fields depending on the batch type.  

You can use wildcard characters in masks, including an asterisk (*) for multiple 
characters, or a question mark (?) for a single character.  For example, to find batch IDs 
that start with the letter "C" you can type in: C*. 

6. Click Search to search for batches matching the specified batch information and attribute 
masks.  

Click Clear to clear all fields and reset default options. 
 

Batch Results 

Batches matching search criteria (page 45) are returned as rows in the batch table. Columns 
may be configured (page 27) to display any available combination of parameters (page 46) 
for each batch.  

You can page through the results or sort them by column: 

• Click the Move Forward (>) or Move Backward (<) navigation to move forward or 
backward on page in the list of returned batches.  

• Click the Move First (|<) or Move Last (>|) buttons to move to the beginning or end of 
the list of returned batches. 

• Click a column to sort the list of returned batches by parameter. 

If a web part connection (page 47) is established, select an individual batch row to send 
selected batch parameters to a connected web part. 
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Configure PI BatchTable Web Parts 

You can configure a PI BatchTable web part using the web part tool pane and standard 
configuration tool parts including Time Range (page 18), Table Columns (page 27), Filter 
Values (page 30), Appearance, Layout and Advanced.  

The PI BatchTable web part also includes two tool parts that allow you to set display 
preferences and configure automatic batch searches. 

Search Options 

By default, all features of the PI BatchTable web part are displayed, allowing the viewer of 
the web part page to search for any type of batch and specify any search criteria.  

Search options provide ways to configure or reduce the search options available: 

• Select Enable Pre-Configured Search to set default search attributes as configured in 
the tool pane. The default search is executed automatically when the page containing the 
web part is loaded.  

• Select Disable Search Interface to hide batch specification properties and search 
attributes in the web part display, showing only the batch table results of a search. When 
this option is selected, search criteria must be pre-configured or supplied externally 
through a web part connection or querystring parameters. 

 

Search Criteria 

The Search Criteria tool part can be used to specify a default attribute mask for PI BatchTable 
searches. Any values supplied in the tool part appear in web part fields as default search 
values. If a pre-configured search (page 45) is specified, a batch search is executed 
automatically using these criteria when the PI BatchTable web part is first loaded on the 
page.  

Default search criteria can be specified for any batch specifications or attribute mask values. 
You can use wildcard characters in masks, including an asterisk (*) for multiple characters, or 
a question mark (?) for a single character.  For example, to find batch IDs that start with the 
letter "C" you can type in: C*. Parameters for all values except Batch Type can also be 
received through web part connections. 

The following batch parameters (page 46) are available as search criteria, depending on the 
type of batch selected: 

• Batch Type 

• Server Name 

• Status 

• Start Time 

• End Time 

• Batch ID 
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• Product 

• Recipe 

• Procedure 

• Unit Name 

• Unit Heading 

Apart from search criteria entered directly in the PI BatchTable web part, parameters may be 
preconfigured, or received through querystring parameters (page 35) or web part 
connections. If parameters are received from multiple sources, the order of execution is 
preconfigured, querystring, web part connections and direct entry. 

 

Batch Parameters 

PI BatchTable uses PI batch information to search for batches on a selected server. More 
detailed batch information is returned in results table rows, where selected rows can send 
batch parameters to connected web parts. 

Note: All parameters, including timestamps in UTC format, are entered and sent as 
strings. 

The following batch parameters are used for searches and appear in batch results: 

Parameter Definition 

Batch Type The type of batch, either: 
 PIBatch, the default option, a PIBatch entity. 
 PIUnitBatch, a PIUnitBatch entity typically associated with a piece of equipment.  
 A PIUnitBatch is by definition associated with a PIModule that has been 

designated to represent the unit (where the property IsPIUnit = True). 
 PISubBatch, an entity which is a child of a PIUnitBatch. or of another PISubBatch 

in a hierarchy beneath a PIUnitBatch.  
For example, you may have distinct types of sub-batches below a PIUnitBatch 
(called Operations) which are called Phases.  

Note that PIUnitBatch replaces the Batch entity in the PI Batch Subsystem. If a 
particular Unit has been migrated to the Batch Subsystem, its child batches are 
interpreted as PIUnitBatches. 

Server 
 

The name of the PI server containing the target PI Batch Database.  
Note that batch data is stored only on the Primary server of a PI server collective. If 
the Primary server is unavailable, you cannot retrieve batch results. Execute the 
search again once the Primary server has been brought back online. 

Status The current status of a batch, either Running or Completed. Completed batches 
have an End Time value; running batches do not. 

StartTime The time at which a batch run started, in UTC format. 

EndTime The time at which a batch run completed, in UTC format. No value indicates a batch 
that is still running. 

Product The name of a product associated with a batch. 
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Parameter Definition 

Recipe The Recipe associated with a batch. 

Procedure The procedure associated with a PIUnitBatch or a PISubBatch. 

Unit Name The name of the unit with which a batch is associated. 

Unit Heading The heading of the PI Module Database unit to which a PIUnitBatch or a 
PISubBatch belongs. 

The following batch parameters appear only in batch search results: 

Parameter Definition 

Batch ID A user-assigned batch ID. 

Duration The total time elapsed during the most recent batch run. If the batch run is 
concurrent to a search, the duration is the time elapsed from start to the execution 
of the search. 

Unit Path The full path to the AF Element that is mapped to the module in the PI Module 
Database to which a batch belongs. A unit path applies only to PIUnitBatch or a 
PISubBatch types. 

Unique ID The unique ID (GUID) of a batch as stored in the PI Batch Database. 
  

PI BatchTable Connections 

The PI BatchTable web part supports SharePoint connections (page 33) to other PI WebParts: 

As a Consumer 
• Accepts time range changes from the PI TimeRange web part, or any other web part that 

provides Start and End timestamps. 

• Accepts Server, Status and Attribute Mask parameters from any web parts that can 
provide them, such as PI TreeView and PI Table. 

Note: Batch Type parameters cannot be accepted through web part connections. 

• Accepts querystring parameters to set initial values. 
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As a Provider 
Column values for rows returned as a result of a PI BatchTable search can be sent to 
consuming web parts using client or server-side connections. When a row is selected, column 
values are sent as parameters (page 46) to connected web parts. 

Note: Null values are provided for parameters that are not applicable to the selected 
batch type. For example, a null value is sent for the UnitName parameter when a 
PIBatch row is sent. 

You can also send a row value from a data column to any web part that can consume it as a 
filter value. A typical use is a connection to the Excel Web Access (EWA) web part (page 36), 
where the column value parameter can be used to resolve a PI DataLink function in a 
spreadsheet cell. 

When selected to launch a web part connection, a batch row displays an active Connection 
icon   to indicate the data sent to a connected web part. 
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The PI Gauge web part provides a graphical view of a PI or other data point's current value, 
and allows you to monitor and determine at a glance whether that value is within an 
acceptable range. 

  
The analog-style gauge has a pointer (similar to a clock hand) that shows the real-time value 
with respect to the scale around the perimeter. A separate gauge appears in the web part for 
each data item configured in the PI Gauge tool pane. 

 

Chapter 8 

The PI Gauge Web Part 
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Note: This web part is rendered in Scalable Vector Graphic (SVG) format and requires 
the Adobe SVG Viewer.  

 

Configure PI Gauge Web Parts 

You can configure a PI Gauge web part using the web part tool pane and standard 
configuration tool parts including Time Range (page 18), Selected Data (page 19), 
Appearance, Layout, and Advanced.  

PI Gauge also includes additional tool parts that allow you to change the measurements, look 
and feel of each gauge. 

PI Gauge Properties 
For PI Gauge web parts, each item in the Selected Data (page 19) table is mapped to an 
individual gauge.  

Use the Multiple gauge orientation setting to specify whether the gauges within the web 
part appear in a horizontal or vertical array. The default value is Horizontal. 

Format Properties 

Format properties determine the scale and appearance of a PI Gauge web part. 

Note: These settings apply only to the currently-selected data item. Choose each item in 
the Selected Data list and apply settings individually to customize the entire web 
part display.  

The Format tool part includes these properties: 

Scale Factor 
The scale factor can be used to modify data point values and the corresponding gauge scale. 
Data point values are divided by the value entered in this field to determine the location of the 
gauge pointer and measurement values along the outside of the gauge. The scale factor is 
displayed at the bottom of the gauge at the end of the legend, if set to a value other than the 
default value of 1. This field accepts floating point values.   

Base Angle 
Enter an integer to describe the angle complementary to the gauge reading arc, represented by 
the open space at the bottom of the display. The PI Gauge reading arc plus the Base angle arc 
is equal to 360 degrees. The default value of the Base angle is 60 (degrees), and can be any 
value between 0 and 359. 
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Number Format 
A number format (page 100) is applied to legend and tooltip values in PI Gauge. Choose each 
item in the Selected Data list and apply settings individually. 

When the Database format is selected for PI tag data, the number of decimal places used for 
floating point numbers is determined by the DisplayDigits (page 101) attribute. This format is 
disabled for non-PI data, which uses the General number format by default. 

Bad Data Color 
A color applied to the gauge center point to indicate an error condition, such as questionable, 
missing or corrupted data point value. The default value is Red. 

Blink 
The gauge center point can be set to blink to indicate an error condition. By default, the check 
box is cleared. 

Text Color 
The color used for text in the web part. The default value is DarkBlue. 

Face Color 
The color applied to the outer ring of the gauge containing scale values. The default value is 
LightGray. 

Background Color 
The color applied to the background of the gauge that is inside the scale ring, and that is 
excluded from the zones by the Base Angle. The default value is LightGray. 

 

Legend Properties 

Legend properties determine the format of the gauge legend and tooltips.  

Note: These settings apply only to the currently-selected data item. Choose each item in 
the Selected Data list and apply settings individually to customize the entire web 
part display.  

The Legend tool part includes these properties: 

Dataset Name 
The name of the dataset column, tag or attribute as it appears in the Selected Data tool part. 

Description 
A description of the selected dataset column, tag or attribute, if available. 
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Units 
The engunits (engineering units) attribute of the PI tag represented on the gauge. Engunits 
indicates the engineering units of measurement for tag data. This field is not applicable to 
non-PI data. 

Value 
The current numeric value represented on the gauge. 

Timestamp 
The time stamp associated with the current value represented on the gauge. 

Title 
Select the checkbox and enter a title to appear directly above the gauge.  

 

Zone and Scale Properties 

Zone and Scale properties determine the overall scale and appearance of a PI Gauge web part.   

Note: These settings apply only to the currently-selected data item. Choose each item in 
the Selected Data list and apply settings individually to customize the entire web 
part display.  

The Zone and Scale tool part includes these properties: 

Maximum and Minimum Scale 
Minimum Scale and Maximum Scale properties determine the range of a values scale for 
each Selected Data item: 

• For floating point or integer PI point values based on a tag or attribute, Database assigns 
the Zero attribute as the minimum scale value, and the Zero plus the Span attribute as the 
maximum scale value. For digital state tags, the minimum is always 0, and the maximum 
is always one less than the total number of states. This option is disabled for dataset 
columns and other non-PI data. 

• Select Custom to enter maximum and minimum values in the accompanying text boxes. 

• Click a Connections  button to map parameters from web part connections to 
maximum and minimum scale values.  

Number of Zones 
The remaining Zone and Scale options are used to format indicator zones that appear on the 
gauge face.  

• Enter a value in the Number of Zones field to specify the number of zones to use. 

The zone list box updates to reflect the correct number. You can select zones from the list to 
define the following for each: 

• Enter a text Label that appears within the zone on the face of the gauge. 
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• Pick a Color for the zone.  

• Select Percentage Zone Setting to determine the size of each zone as a percentage of the 
total scale, as specified by the Total Scale Percentage. Clear the check box to specify 
the zone sizes using a High Value (the Low Value is calculated automatically). 

 

PI Gauge Connections 

The PI Gauge web part supports SharePoint connections (page 33) to other PI WebParts: 

As a Consumer 
• Accepts time range changes from the PI TimeRange web part, or any other web part that 

provides Start and End timestamps. 

• Accepts PI tag names from any other web part and adds them to Selected Data as 
additional gauges.  

• Accepts maximum and minimum scale value for a gauge. 

• Accepts querystring parameters to set initial values. 
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The PI Graphic web part shows PI ProcessBook displays saved in Scalable Vector Graphic 
(SVG) format. ProcessBook displays allow you to monitor a selected area of a plant in near 
real-time using schematic diagrams, dynamic graphic elements, multistate symbols, and 
continuously updating graphs and data point values.  

 
PI Graphic supports displays created in PI ProcessBook 2.35 or higher with the SVG Add-in 
version 2.25 or higher.  

Note: This web part is rendered in Scalable Vector Graphic (SVG) format and requires 
the Adobe SVG Viewer.  

 

ProcessBook Display Support 

PI ProcessBook display graphics are PI ProcessBook displays saved in Scalable Vector 
Graphic (SVG) format. SVG displays preserve most of the functionality of native 
ProcessBook displays, but are easier to deploy to users. 

SVG format supports both static and dynamic content elements used in PI ProcessBook. 
Keep the following in mind when creating and saving displays in SVG format for PI Graphic: 

Chapter 9 

The PI Graphic Web Part 
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• Static content may include rasterized images, photographs, line drawings, or text, as long 
as the format for these images is viewable on the web. For instance, displays that contain 
.jpg, .png, or .gif images can be viewed in a PI Graphic web part, but embedded symbols 
in .bmp format cannot.  

• Dynamic elements include values, bars, trends, XY plots and multistate symbols that may 
be updated when the data on a PI Server or other data source changes. Dynamic elements 
vary in appearance depending on the type of data displayed and their configuration. Blob 
tags are not supported for any dynamic symbol. 

• ActiveX controls used to build ProcessBook displays are omitted when the display is 
saved in SVG format. 

• Any VBA scripting written to support a ProcessBook display cannot be included when 
the display is saved in SVG format. 

• For more information about ProcessBook elements, see the PI ProcessBook User Guide. 

Value Attribute Icons 
Value attribute icons represent substituted, annotated or questionable data. For example, on 
trends the icons are displayed on the axis opposite the time scale, at the time the value 
attribute is indicated. Value attribute icons for the last value in the plot are displayed next to 
the legend. 

• Substituted  indicates that the value has been changed from its original value. This value 
is set only by the PI Archive Subsystem when an existing value is changed. 

• Annotated  indicates that there is a comment about a value.  

• Questionable  indicates that there is some reason to doubt the accuracy of the value. 

When more than one value attribute applies, the highest priority attribute is rendered. 
Attribute priorities from highest to lowest are: Error, Questionable, Annotated, and 
Substituted.  

Click the icon to display the value attribute data in a dialog. 

Note: While the display of value attribute icons can be disabled in PI ProcessBook as an 
application-wide setting, value attribute icons that appear in the original 
ProcessBook display are displayed automatically and cannot be toggled on or off 
in PI Graphic web parts. 
Value attribute icons may not be present on secondary PI servers in a collective. 

Value Symbols 
A value symbol (usually numeric) displays a spot value for a particular data point. A value 
may include a tag name or a timestamp. For digital state tags, a state label (rather than index 
number) is displayed.  

By default, the most recent value is retrieved from the snapshot table. If the time range end 
time is changed to a value other than *, the end time is used to retrieve a value. Integer and 
floating point data are displayed using default number formats (page 100), with decimal and 
group separator characters specified by the SharePoint locale (page 7). Non-PI data is 
displayed as returned from the data source with formats specified by the web part. 
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Trend Symbols 
Trend symbols in PI Graphic web parts use the same logic as the PI Trend web part, with the 
exception that interactivity features such as zooming, cursors, and tooltips are not supported 
in PI Graphic. 

XYPlot Symbols 
The PI Graphic web part displays any XY Plot symbols found in the selected .svg file as they 
were configured in PI ProcessBook. Interactivity features, such as zooming, cursors and 
tooltips are not supported in PI Graphic.  

Linked Displays 
If a saved PI ProcessBook display file (.svg) has a ProcessBook button with a linked display, 
you can use it to launch the .svg file directly in PI Graphic. Unless a full URL is specified, PI 
Graphic assumes a linked file is located in the same path as the current display.  

If the button references a .pdi file, the web part assumes that an .svg version is the intended 
target, and searches for the .svg extension. Hovering the mouse over the button area changes 
the mouse pointer to a hand to indicate that a hyperlink is active. 

Image files may be linked or embedded. Linked files should be referenced with relative paths 
accessible to the SharePoint server. Embedded files must be located in the same folder as the 
saved .svg file. To ensure that display elements are preserved in PI Graphic, retain linked or 
embedded image files in the same folder as the .svg file. 

Other ProcessBook button types are not supported, including links to other file types (.piw 
and .pdi), macros (VBA scripts) or operating system commands.  

 

Dataset Support 

PI Graphic supports PI ProcessBook display graphics built with PI data, PI Calculation 
datasets or ODBC datasets.  

Any data source used in the display must be accessible to the SharePoint server in order to 
update content in PI Graphic. For ODBC datasets, a corresponding Relational Data Source 
with an identical System Data Source Name (DSN) must exist in PI Data Services.  

For example, a PI ProcessBook user connects to an ODBC data source on his computer 
through a System DSN named MySQLData. The user builds a ProcessBook display with the 
ODBC data and saves it in .svg format. Before using the .svg in PI Graphic, the user must 
create or verify the existence of a corresponding Relational Data Source called MySQLData 
for the PI WebParts server through PI Data Services.  
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Create a ProcessBook Display Graphic (.svg) 

ProcessBook displays can be saved in .svg format using the File > Save As menu command 
in PI ProcessBook. 

Note: Displays in SVG format are preserved as they appear when saved in 
ProcessBook. For more information about resizing a display, see the PI 
ProcessBook User Guide.  

To save a PI ProcessBook display to an SVG document: 

1. Open a PI ProcessBook display in PI ProcessBook. 

2. Make any changes to the display that you want to see in PI Graphic. 

3. Select the desired default element-relative context or module path.  

Module-relative displays are automatically converted to element-relative displays when 
loaded into PI Graphic web parts. 

The last path selected when the document is saved to .svg format in PI ProcessBook 
becomes the default context used when the display is loaded into the PI Graphic web part.  

4. Verify that a Data Source corresponding to the DSN (page 57) exists in PI Data Services 
to support any relational datasets used in the display, and that tags for PI servers 
referenced in the display are accessible from the web server.  

5. Go to the File menu and select Save As. 

6. Select the file type Scalable Vector Graphics (SVG).  

7. Navigate to the desired network directory location (page 15). 

8. Name the file appropriately and click Save. 

9. If the display contains linked or embedded graphics, make sure to locate the correct 
graphic files and copy them to the same network directory location where you saved the 
SVG: 

ο For a linked graphic, copy the actual linked graphic file. 
ο For an embedded graphic, copy the graphics saved with the SVG. ProcessBook 

creates a new image in the same directory as the saved SVG using a variation of the 
SVG file name for each embedded graphic.  

10. Close PI ProcessBook. 
 

Configure PI Graphic Web Parts 

You can configure a PI Graphic web part using the web part tool pane and standard Time 
Range (page 18), Appearance, Layout and Advanced tool parts.  

PI Graphic also includes two additional tool parts that allow you to select ProcessBook 
display graphics in SVG format, and a context path for the display. 
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PI Graphic Configuration 

The PI Graphic Configuration tool part is used to specify the display contents for the web 
part:  

• Use the Selected File field to indicate the .svg file you want to show in PI Graphic.  

• Use the XSL Transform File field to provide an optional XSL transformation (.xslt) file 
to change or enhance the appearance of the SVG graphic without permanently altering its 
contents.  

Transformation logic can include pattern-based substitution to change tags or server 
names, to adjust the visual representation of a display, or to attach JavaScript logic to 
specific elements, for example. 

For each option, you can enter a full path to a file, or enter a partial path and click the 
downward arrow to Browse or Search for a file. Paths may use a UNC path to a file share 
located on the web server, such as 

\\servername\directory\file.svg 

or an absolute or relative URL, for example: 
http://myserver/directory/file.svg  

You can also click the Connections  button to receive a file path through a web part 
connection. 

 

Current Context Path 

The Current Context Path tool part allows you to manage the context (page 26) of PI 
ProcessBook displays (.pdi or .svg) in PI ActiveView and PI Graphic web parts. Context 
paths operate as parameters you can use to dynamically present different PI data in the same 
file display. 

The PI Graphic web part automatically converts module-relative displays to element-relative 
displays that can be changed dynamically using AF context paths, provided your asset data 
has been migrated to an AF Server from the PI Module Database. 

PI ProcessBook displays an element-relative attribute path with the e. prefix. PI Graphic uses 
a .| prefix rather than e.. For example, the specification e. attribute displays as .|attribute in 
PI Graphic. If the attribute is defined using the Full Path option, the context path is displayed 
with a .\ prefix. For example e..\element|attribute in ProcessBook would appear as 
.\element|attribute in a PI Graphic web part. 

The last context (or module) path selected when the display file was saved in PI ProcessBook 
becomes the default context. Once a PI ProcessBook display file is referenced by a web part, 
use the Override Default Context Path field to define a new default context when the file is 
loaded in the web part. You can also send context paths to the web part from provider web 
parts. 

To override a default context path, use the Connections  button to drive the module 
context for PI Graphic through other web parts on the page. 
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For example, to create a display that allows you to toggle between attributes under Unit 1 
and Unit 2 elements (and show corresponding data for each), you can connect a PI 
TreeView web part to a PI Graphic web part and send a context path. 

The target web part displays an.svg (PI Graphic) display configured to use the same 
named attributes. Map the relative path parameter from the PI TreeView to the Context 
Path field on the PI Graphic web part. 

Once configured, click on the Unit 2 module in PI TreeView when you want to see data 
from Unit 2 instead of Unit 1, and vice versa. 

  

Ad hoc SVG Views 

When a PI ProcessBook display graphic appears in a PI Graphic web part, you can open 
additional views of the graphic as needed:  

• In the upper right part of the PI Graphic web part, click the downward arrow , and 
then click Ad hoc SVG. The SVG view opens in a new browser window. 

You can also right-click on the PI Graphic web part and choose Ad hoc SVG to display 
the graphic in a new, resizable SVG view window.  

If a data item appearing in the SVG view can be plotted as a trend, you can right-click 
and choose Ad hoc Trend to display a corresponding Trend (page 11). 

The time range of the parent web part is used to determine the time range for the SVG view 
when it is first opened. SVG views are opened in a new window with controls that allow you 
to scroll the time forward and backward, launch a trend, zoom, or change the time range. 

 

SVG Display Controls 

PI Graphic displays and SVG views (page 60) support Pan and Zoom capabilities provided by 
the Adobe SVG Viewer:  

• To pan, press the ALT key, then click and drag the image.   

• To zoom in, press the CTRL key and click on the image to zoom, or right-click and select 
Zoom. To zoom out, press SHIFT and CTRL, and click on the image or right-click to 
show the context menu and select Zoom Out or Original View. 
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Time Controls 

Use the following tools to set or adjust the time range: 

• Enter a value in the Start field to specify the start of the time range. Time can be 
expressed in PI time format or the default Windows Short Date and Time format 
configured for SharePoint.  

• Enter a value in the End field to specify the end of the time range. Time can be expressed 
in PI time format or the default Windows Short Date and Time format configured for 
SharePoint. 

• Click Apply to apply updated time values.  

• Click the Revert  button to restore default start and end time values. 

• Click the Scroll Back/Scroll Forward  buttons to adjust Start and End times 
backward or forward by the amount of the current interval duration. If the Start and End 
values are relative times in PI format, scrolling converts the values to absolute times. 
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PI Graphic Connections 

The PI Graphic web part supports SharePoint connections (page 33) to other PI WebParts: 

As a Consumer 
• Accepts time range changes from the PI TimeRange web part, or any other web part that 

provides Start and End timestamps. 

• Accepts element-relative context paths (from PI Table and PI TreeView web parts, for 
example) to update dynamic content associated with PI Attributes.  

• Accepts querystring parameters to set initial values. 

As a Provider 
• Provides symbol names and data sources (semicolon delimited) to other web parts.  
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The PI Table web part presents row and column data in tabular format. PI Table also supports 
formatting configurations you can apply to specify the appearance and attributes of table cell 
data.    

 

PI Table is particularly useful for displaying relational data from ODBC, OLE DB and other 
sources, and from PI Calculation and web services datasets. 

Note: PI WebParts data sources and datasets are configured in PI Data Services by an 
administrator. For more information, see the PI Data Services Administrator 
Guide. 

 

Configure PI Table Web Parts 

You can configure a PI Table web part using the web part tool pane and standard 
configuration tool parts including Time Range (page 18), Table Columns (page 27), Filter 
Values (page 30), Appearance, Layout and Advanced.  

The modified Selected Data (page 19) tool part provides access to configured relational, web 
service and PI Calculation datasets only. 
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PI Table Connections 

The PI Table web part supports SharePoint connections (page 33) to other PI WebParts: 

As a Consumer 
• Accepts time range changes from the PI TimeRange web part, or any other web part that 

provides Start and End timestamps. 

• Accepts SQL query parameters and placeholder values from any web parts that can 
provide them, such as PI TreeView and PI Table. 

• Accepts querystring parameters to set initial values. 

As a Provider 
• Column values can be sent to consuming web parts as parameters when a row is selected. 

Examples include columns of tag names, context paths, timestamps, numeric values used 
to resolve numeric placeholders, or PI Unit names used to resolve Text placeholders.  

• PI Table column values can also be formatted as hyperlinks using table configuration 
formats. These hyperlinks can be configured to navigate to a different page, open a new 
page or launch a row connection. 

• You can also send a column value from a selected row to any web part that can consume 
it as a filter value. A typical use is a connection to the Excel Web Access (EWA) web part 
(page 36), where the column value parameter can be used to resolve a PI DataLink 
function in a spreadsheet cell. 

PI Table rows can be configured to provide the following: 

• PI tag names to PI Trend, PI XYPlot, and PI Gauge web parts. 

• SQL query parameters to PI Trend, PI XYPlot, and PI Table web parts. 

• File URLs to PI Graphic and PI ActiveView web parts. 

• Contact information datasets to PI Messenger web parts. 

When a column value is clicked to launch a web part connection, a row displays an active 
Connection icon  to indicate the data sent to a connected web part. 
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The PI TimeRange web part allows you to set time ranges for all web parts on a page, and 
scroll the time range backward and forward by interval. 

 

PI TimeRange features are identical to the time range tools available to most web parts 
through the tool pane. However, PI TimeRange allows you to enter time ranges directly on a 
web part page in run mode, without modifying individual web part tool panes.  

An implicit connection (page 66) is created between the PI TimeRange web part and all other 
OSI web parts on that page that can consume time ranges, when the PI TimeRange web part 
is added to a page. This connection allows you to set or change time ranges for other PI 
WebParts simultaneously. You can override this behavior by mapping explicit time range 
connections between web parts, to allow individual time settings. 

 

Set a Time Range 

 

Use the following tools to set or adjust the time range: 

• Enter a value in the Start field to specify the start of the time range. Time can be 
expressed in PI time format or the default Windows Short Date and Time format 
configured for SharePoint.  

• Enter a value in the End field to specify the end of the time range. Time can be expressed 
in PI time format or the default Windows Short Date and Time format configured for 
SharePoint. 

• Click Apply to apply updated time values.  

• Click the Revert  button to restore default start and end time values. 

• Click the Scroll Back/Scroll Forward  buttons to adjust Start and End times 
backward or forward by the amount of the current interval duration. If the Start and End 
values are relative times in PI format, scrolling converts the values to absolute times. 
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• Click a Calendar  button to display a calendar picker. Enter a time and click a date to 
set a Start or End time. Scroll through months using the arrow buttons at top.  

 

Implicit Time Range Connections 

A PI TimeRange web part can supply Start and End Times to all other PI WebParts on a page 
that are designed to consume time ranges, without being explicitly connected to them. This 
implicit connection allows web parts on a page to display data over the same time range 
through a single point of control and without configuration. 

In order of precedence, a web part can collect time range parameters from three sources:  

• An explicit SharePoint connection to another web part, where the Connections button  
appears green in the Time Range tool part. 

• An implicit connection to an instance of PI TimeRange. 

• Start and End time values specified directly in the Time Range portion of a tool part. 

Implicit connections are created when a PI TimeRange web part is added to a page. All 
applicable web parts automatically collect Start and End Times from PI TimeRange 
regardless of their configuration, unless they are specifically configured to receive a time 
range from another provider web part.  

If you want to use different time ranges for web parts on a page, you can add additional PI 
TimeRange web parts, and create explicit connections to each. Any remaining web parts 
maintain an implicit connection to the first instance of PI TimeRange added to the page, and 
react automatically to time changes made in that provider web part.  

 

Configure PI TimeRange Web Parts 

You can configure a PI TimeRange web part using the web part tool pane and the standard 
tool parts including Time Range (page 18), Filter Values (page 30), Appearance, Layout and 
Advanced, and an additional Display Properties tool part used to change the orientation of the 
web part. The Time Range tool part determines the default time range for the PI TimeRange 
web part. 

PI TimeRange web parts can be displayed in horizontal or vertical orientation. 

To change the orientation: 

• Choose Horizontal to display time range controls as a single row across the width of the 
page zone, with buttons to the right. 

• Choose Vertical to display time range controls centered and aligned top to bottom, with 
buttons centered at the bottom. 
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PI TimeRange Connections 

The PI TimeRange web part supports SharePoint connections (page 33) to other web parts. 

As a Consumer 
• Accepts querystring parameters to set initial values. 

As a Provider 
• Provides initial time range and updates through implicit or explicit connections. 

• Provides time and status parameters (page 67) to third-party web parts. 

• Provides parameters as filter values to consumer web parts, such as the Excel Web Access 
(EWA) (page 36) web part. In the EWA web part, the parameter value can be used to 
resolve a PI DataLink function in a spreadsheet cell. 

 

Third-Party Web Part Connections 

You can connect PI TimeRange to third-party web parts to send date and time information. 
Two alternate time forms are available to facilitate PI TimeRange connections to third-party 
web parts. 

The values 
Start Time (Localized) 
End Time (Localized) 
Current Time (Localized) 
Time Range (Localized) 

provide values expressed as Windows-based timestamps formatted according to the site's 
locale (page 7) setting. Time Range includes both start time and end time, delimited by a 
semicolon.  

The values 
Start Time (UTF) 
End Time (UTF) 
Time Range (UTF) 

provide values in Universal Time Format (UTF), which matches the string format specified 
by ISO-8601 Section 4.3.2 (Date and Time of Day – Extended Format): 

YYYY-MM-DDThh:mm:ss 

An additional parameter, the IsUpdating flag, indicates whether a time range is an updating 
time range. PI WebParts use this flag to determine if they need to poll PI Data Services for 
updates. 
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The PI TimeSeries web part displays time series data, usually from the PI Data Archive, in 
tabular format along with many other PI tag attributes. 

 
PI TimeSeries web parts can also display PI calculation, relational and web service datasets in 
time series format. To use a dataset, select the dataset column that contains the values you 
want to display in PI TimeSeries. Columns configured in the web part for PI tags, and that do 
not have corresponding column names in the dataset, show blank data.  

PI Table configuration formats can be created for time series datasets and applied to PI 
TimeSeries web parts to add custom formatting. 

 

Configure PI TimeSeries Web Parts 

You can configure a PI TimeSeries web part using the web part tool pane and standard 
configuration tool parts including Time Range (page 18), Selected Data (page 19), Table 
Columns (page 27), Filter Values (page 30), Appearance, Layout and Advanced.  

Note: PI TimeSeries automatically includes the first time column in a dataset to provide 
timestamp data. 

 

PI TimeSeries Connections 

The PI TimeSeries web part supports SharePoint connections (page 33) to other PI WebParts: 

As a Consumer 
• Accepts time range changes from the PI TimeRange web part, or any other web part that 

provides Start and End timestamps. 

• Accepts PI tag data sources from any other web part and adds them to the list of 
configured data. 
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• Accepts querystring parameters to set initial values. 

As a Provider 
• Column values can be sent to consuming web parts as parameters when a row is selected.  

• Provides a column value from a selected row as a filter value, through an 
ITransformableFilterValues connection. For example, the column value can be consumed 
by the Excel Web Access web part and used to resolve a PI DataLink function in a 
spreadsheet cell. 
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The PI Messenger web part displays the online status of a list of instant messaging (IM) 
contacts provided through Windows or MSN Messenger services.  

Note: PI Messenger requires Microsoft Office 2003 or higher, and either Windows 
Messenger, Windows Live Messenger, MSN Messenger, or MS Office 
Communicator IM clients installed on the client computer.  

To retrieve addresses from Outlook Address Book, Outlook XP or the Outlook 2003 
Address Book Control must also be installed.    

 

Configure PI Messenger Web Parts 

You can configure a PI Messenger web part using the web part tool pane and standard 
Appearance, Layout and Advanced tool parts. The modified Selected Data (page 19) tool part 
for PI Messenger web parts provides access to configured datasets only. For example, an 
administrator can create a contact list with IM addresses and save it as a data source in PI 
Data Services. 

PI Messenger also includes two additional tool parts that allow you to manage a list of 
contacts and how they are displayed in PI Messenger. 

Contact List Properties 

The Contact List tool part allows you to build and maintain a list of contacts available to the 
PI Messenger web part. 

• Enter contacts manually using the entry fields at the top of the Contact List table. Each 
row in the list below represents a single contact, including an Instant Messaging (IM) 
Address, Display Name, and display Group. The IM Address is the only required field.  

• Click the Add (+) button to add contact information in the fields to the contact list. 

• You can import contacts or groups directly from Microsoft Outlook by clicking the 
Address Book  button. Select the contacts you want to add and click OK to import the 
list.  

Note: The Outlook 2003 Address Book Control (page 72) must be installed on the 
client computer to use the Address Book feature.  
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• Use the up  and down  arrow buttons to reorder contacts in the list. 

• Click the selection button to the left of a contact to edit contact information. 

• Click check boxes next to contacts and then the delete  button to delete selected 
contacts. Click the clear  button to remove all contacts from the list. 

 

Outlook Address Book Control 
The Outlook 2003 Address Book Control must be installed on the client computer to use the 
Address Book feature. Otherwise, PI Messenger displays an error message indicating that the 
client computer is not properly configured when the user clicks the Outlook Address Book 
button. 

The Outlook Address Book Control is not selected by default in a typical installation of 
Microsoft Outlook XP or 2003.  To enable this feature, perform the following steps. 

1. Run the Microsoft Office Setup program. 

2. Choose Add or Remove Features. 

3. Check the box labeled Choose Advanced Customization of Applications. 

4. Expand the tree node for Microsoft Office Outlook. 

5. Select Address Book Control and choose Run From My Computer. 

6. Click Update. 

To get the Outlook Address Book Control from an Office XP installation, follow the Office 
2003 steps, but ignore step 3. 

 

Settings Properties 

The Settings tool part provides access to pre-defined configurations for the dataset selected in 
the Selected Data section. Saved configurations allow you to:  

• define the names of selected dataset columns to use for the Group Name, Display 
Name, and IM Address fields.  

• define an Active Directory address that can be used to browse for predefined groups of 
users, and that also defines the names of the Display Name and IM Address fields. 

If you select a pre-defined configuration that defines a valid Active Directory address, the 
Active Directory Group configuration in Settings is enabled. You can then search the Active 
Directory for groups: 

• Enter group names using the Active Directory Groups field. Members of a referenced 
group are included in the PI Messenger contact list. Multiple group names can be 
specified, separated by semicolons.  

You can also click Browse to display a tree of organizational unit objects found at the 
Active Directory location. Select nodes in the tree and click Apply to add associated 
groups or names to the contact list. Click OK to add the name of the selected node.  
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You can also use the Connection  button to pass an Active Directory path and group 
name from another web part. 

• Select a configuration from the Saved Configurations menu, or the blank configuration 
to use system defaults.  

The Configure  button opens the PI Messenger Configuration page where you can 
create or edit contact configurations.  

Note: PI WebParts data sources and datasets are configured in PI Data Services by 
an administrator. For more information, see the PI Data Services 
Administrator Guide. 

• Choose an Arrange Contacts By option to sort contacts in the PI Messenger contact list 
by Group or by Online/Offline Status.  

 

PI Messenger Connections 

The PI Messenger web part supports SharePoint connections (page 33) to other PI WebParts: 

As a Consumer 
• Accepts LDAP Active Directory paths from other web parts to update IM contact lists.  
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The PI TreeView web part is a navigational control most typically used to browse assets in an 
AF database and set context paths for other web parts. By providing AF Element and 
Attribute data to other web parts through web part connections, PI TreeView can drive the 
view of assets provided by web parts in the page. 

 
PI TreeView web parts can pass AF Attributes and context paths to both PI WebParts and 
third-party or custom web parts.  

Note: PI TreeView respects access restrictions applied within the AF Server. Users must 
have Read access to an element or attribute to see it in the web part.  

 

Configure PI TreeView Web Parts 

You can configure a PI TreeView web part using the web part tool pane and standard Filter 
Values (page 30), Appearance, Layout and Advanced configuration tool parts. 

Browse PI TreeView 

You can browse and configure hierarchical AF database trees for use in PI TreeView web 
parts. PI TreeView allows you to drive other web parts in the web part page. By selecting 
individual nodes in the tree, you can send attributes and their context paths to connected web 
parts.  

To browse or configure a tree: 

1. Click the Browse button in the PI TreeView tool pane to display the Configure AF 
TreeView dialog. 

2. Choose an AF Server from the list of available Servers. 

3. Choose an AF database from the list of Databases within the selected AF Server.  
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Note: The top level of the tree is specified by the Root Node until you select a 
different Server and Database, or specify a different root node. 

 
Expand the tree to find the desired elements and then drag them into the settings fields at 
bottom to set paths. You can also right-click an element and use the context menu to save it to 
a field. 

Root Node 
A path to the root node of a tree that appears in the PI TreeView web part, such as: 

\\<AF Server Name>\<AF Database Name> 

The root node should specify a parent that includes all descendent elements and attributes 
desired for use. This parameter is required to configure the web part. 

Default Selected Node 
An optional path to an element used as the default selected node for the web part. The path 
uses the following format: 

\\<AF Server Name>\<AF Database Name>\<Element> 

Attributes of the specified element path are sent to connected web parts automatically when 
the page is loaded. 

 

Choose Attribute Parents 

When using the PI TreeView web part to drive other web parts, you may need to specify 
which AF Attributes are available for web part connections. Attribute parents are AF 
Elements or Attributes whose child attributes are available for connection.  
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Attribute parent objects can reside anywhere in the PI System AF hierarchy. You can specify 
multiple attribute parents. At run-time a context path is set by selecting an element from the 
tree. Attributes are matched by name, based on the connection details. 

You can also send a comma-separated list of attribute parents at page load time using a 
querystring parameter (page 35).  

Note: Attribute parent lists cannot be sent from a provider web part. 

To choose attribute parents:   

1. Click Choose Attribute Parent . 

2. Browse through the tree and select AF objects to add them to the list of parents. 

3. Click OK.  

 
 

Display Properties 

Number of Levels Initially Loaded 
The number of node levels to be read initially from the AF database relative to the root node. 
The default value is 2. If the Maximum Number of Levels to Display is greater than this 
value, additional nodes are loaded when the tree view is expanded in the web part.  
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Number of Levels Initially Displayed 
The number of node levels initially shown expanded relative to the root node. The default 
value is 2. Any additional levels loaded appear collapsed, but can be expanded up to the 
Maximum Number of Levels to Display. 

Maximum Number of Levels to Display 
The maximum number of node levels to display at any time relative to the root node. Nodes 
beyond the maximum level do not appear even if all visible nodes are fully expanded. The 
default value is 8. 

URL to Icons 
An absolute or site-relative location for stored image files used as descriptive icons for tree 
nodes. This can be a fully-qualified URL to an image file or only a graphic file name, in 
which case a URL property of an attribute is used to resolve the icon location.  

The default value is read from the imagedirectory setting in the 
PIPC\RtWebParts\web.config file on the web server. 

Note: If this value is changed, the default icons may not be found by the web part. Be 
sure to copy those icons needed for the proper display of the tree. 

 

PI TreeView Connections 

The PI TreeView web part supports SharePoint connections (page 33) to other PI WebParts: 

As a Provider 
Data associated with an AF Attribute can be sent to connected web parts. This data can be in 
the form of PI point values or stored directly in AF. 

PI TreeView can provide the following AF data through a web part connection: 

• The name, relative context path or fully-qualified path to an element 

• A list of tags associated with the attributes that are an immediate children of the element 
as references 

• The value of an attribute 

The data sent for a selected attribute depends on the data referenced by the attribute. 
Attributes that reference non-PI data sources send the value associated with that attribute on 
the specified Query Date. Attributes that reference a single PI point send a tag name.  

Note: For most web parts, data is displayed using the AF Attribute's default unit of 
measure, regardless of whether an underlying PI point has different units. For PI 
TreeView, which passes on an underlying PI point tag name, a consuming web 
part shows data using the default units for the PI tag, not the units defined for the 
AF Attribute. 
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These items may be consumed by other web parts as follows: 

• As a filter value (page 30). For example, the item can be consumed by the Excel Web 
Access web part and used to resolve a PI DataLink function in a spreadsheet cell. 

As a Consumer 
• Accepts a Query Date value from a web part connection. 

• Accepts querystring parameters to set initial values. 
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The PI Trend web part presents data in an interactive format that can update with new data to 
display data trends in real-time.  

PI Trend allows you to track PI point values over time, show the results of an ODBC or OLE 
DB query, or combine data from PI, relational and web service data sources. You can contrast 
trends among different tags or attributes, or plot them against a PI calculation dataset such as 
a moving average of the same underlying PI point. 

 

Each trace drawn in the plot area of the trend represents a single stream of time series data in 
an X-Y coordinate system. The X-coordinate represents a time stamp (date and time) and the 
Y-coordinate represents a numeric value.  

Trends (page 11) can also be generated and viewed as needed from other PI WebParts, and 
share most of the same display options and controls.  

Note: This web part is rendered in Scalable Vector Graphic (SVG) format and requires 
the Adobe SVG Viewer.  

 

Chapter 15 

The PI Trend Web Part 
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Configure PI Trend Web Parts 

You can configure a PI Trend web part using the web part tool pane and standard 
configuration tool parts including Time Range (page 18), Selected Data (page 19), 
Appearance, Layout and Advanced. 

PI Trend also includes an additional Trend Properties tool part that allows you to set scales 
for trend traces and form the display of legends and other data items.  

Value Scale Properties 

A PI Trend web part has a time scale and at least one value scale. Most trends display time 
along the horizontal (x) axis, but you can change the display orientation so that the time scale 
appears on the vertical (y) axis.  

Note: These settings apply only to the currently-selected data item when Multiple value 
scales is selected. Choose each item in the Selected Data list and apply settings 
individually to customize the entire web part display.  

The Value Scale tool part includes these properties: 

Scale Range 
Minimum Scale and Maximum Scale properties set the range of additional Y Value scales, 
if enabled, for each Selected Data item. The following options provide different means to 
determine minimum and maximum scale values: 

Autorange  
Autorange calibrates the scale automatically using actual data values whenever updates are 
received. The calibration depends on the Multiple Y Value Scales setting: 

• If Multiple Value Scales is selected, each trace has its own values scale. The lowest and 
highest values for each trace determine the minimum and maximum values for the 
corresponding scale.   

• If Multiple Value Scales is not selected, a single scale is used for all traces. The lowest 
minimum and highest maximum values currently plotted for all traces are used as 
minimum and maximum values for the combined scale. 

Database 
For floating point or integer PI point values based on a PI Point, or an AF Attribute that refers 
to a PI Point, Database assigns the Zero attribute as the minimum scale value, and the Zero 
attribute plus the Span attribute as the maximum scale value. For digital state tags, the 
minimum is always 0, and the maximum is always one less than the total number of states. 
This option is disabled for dataset columns and other non-PI data. 
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Custom  
Custom applies user-specified minimum and maximum scale values entered in the 
accompanying text boxes.  

Number Format 
A number format (page 100) is applied to scale, legend, tooltip and cursor values per each 
additional Y Values Scale, if enabled, in PI Trend. Choose each item in the Selected Data list 
and apply settings individually. Choose each item in the Selected Data list and apply settings 
individually. 

When the Database format is selected for PI point data, the number of decimal places used 
for floating point numbers is determined by the DisplayDigits (page 101) attribute. This 
format is disabled for non-PI data, which uses the General number format by default.  

Invert Scale 
Inverts minimum and maximum scale values such that values decrease moving away from the 
origin along the value scale. The default value (unchecked) places the minimum scale value 
at the origin. 

Logarithmic 
Displays scale and trace values on a base-10 logarithmic scale. This property is not applicable 
to string, digital or integer data. The default value (unchecked) uses a linear scale. 

Data Markers 
Displays distinguishable data markers for each value stored in the data source. Data markers 
provide a visual reference other than trace color, and are used to reference traces in legends, 
tooltips and cursors. 

Stepped 
Determines how to plot traces on a trend. By default, traces are drawn according to the tag, 
attribute or dataset definition. When set to On, traces are forced to draw in stepped format. 
When set to Off, traces are forced to draw as continuous lines. 

 

Display Properties 

Trend display properties determine how visual elements of a PI Trend web part are displayed. 

Time Scale 
Default time scale values use a full timestamp format, but other timestamp formats are 
available: 

• Full timestamp displays start time at the origin and end time at the far end of the time 
scale. 

• Partial timestamp displays evenly spaced date or time units along the time scale axis, as 
space permits.  
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For example, an eight-hour plot may display individual hourly time values along the time 
scale. The current date and time appear in the upper right corner. 

• Relative timestamp displays time unit offsets from the End Time.  

Using the previous example, the scale would be labeled -1 to -7 moving from the end to 
the beginning of the time scale axis. The units are displayed in the middle of the scale, 
with current date and time displayed in the upper right corner of the trend. 

Time Label 
The label used for the scale: 

• The default value Duration expresses units appropriate to the actual time range duration 
of the plot.  

• Units displays time units represented by trend gridlines used in the plot.  

• None displays no time axis label. 

Legend 
Use the legend group to determine the information that appears in the trend legend. A marker 
for each trace is shown to the left of selected items. If no options are selected, the legend does 
not appear. By default, all checkboxes in the Legend group are checked. If space is limited, 
the legend may not appear on the trend. 

• Dataset Name displays the name of each trace in the order it appears on the Selected 
Data list in the tool part. 

• Description displays the descriptor attribute of a PI tag or the description for a dataset 
column at the bottom of the plot. 

• Last Value displays the most recent or last value for each trace shown on the plot. 

• Units shows the engunits attribute for PI tag traces. 

Display Options 
Display options control the display of certain trend plot items. With the exception of 
gridlines, display options are not enabled as default settings: 

• Title displays the contents of the text field in the top left corner of the plot if the 
checkbox is enabled. The default title text is Plot0. If no title text is entered, a title does 
not appear in the plot. 

• Scales inside axis toggles the display of value scales inside or outside the value axis of 
the plot.  

• Multiple value scales displays individual values scales for each trace. When cleared, a 
common scale is calculated for all traces. 

• Show Grids displays horizontal and vertical grid lines corresponding to scale markers 
within the trend plot. 

• Show Value Attributes toggles the display of value attribute icons applicable to trend 
data. 
ο Substituted  indicates that the value has been changed from its original value. This 

value is set only by the PI Archive Subsystem when an existing value is changed. 
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ο Annotated  indicates that there is a comment about a value.  
ο Questionable  indicates that there is some reason to doubt the accuracy of the value. 

When more than one value attribute applies, the highest priority attribute is rendered. 
Attribute priorities from highest to lowest are: Error, Questionable, Annotated, and 
Substituted.  

Trend Orientation 
Trend Orientation settings allow you to configure the orientation of the trend and axes:  

• The Horizontal icon  sets the trend to the default horizontal display, with time 
plotted on the X axis and Start Time to the left.  

• The Descending Vertical icon  sets the trend to display vertically with time plotted 
on the Y axis and Start time in the top left corner. The value scale is shown horizontally 
at the top of the plot.  

• The Ascending Vertical icon  sets the trend to display vertically with time plotted on 
the Y axis and Start time in the bottom left corner.  The value scale is shown horizontally 
at the bottom of the plot. 

 

Trend Formatting Properties 

If specific formats are defined for your site under PI Data Services, you can select and apply 
one to PI Trend web parts:  

• Select and apply a named format from the Trend Formatting list. The default value is 
System Default. 

• If you are a PI WebParts administrator, you can use click the Configure  button to 
edit or add new formats. A configuration page opens in a new browser window with 
specific formatting tools.  

See the PI WebParts Administrator Guide for more information about defining named 
formats. 

 

PI Trend Connections 

The PI Trend web part supports SharePoint connections (page 33) to other PI WebParts: 

As a Consumer 
• Accepts time range changes from the PI TimeRange web part, or any other web part that 

provides Start and End timestamps. 

• Accepts PI tag or attribute data sources from any other web part and adds them as 
additional trend traces.  

• Accepts querystring parameters to set initial values. 
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The PI Values web part presents single point events from a time series, such as a current tag 
value and related information, in tabular form.  

 

PI Values is particularly useful for calculating and displaying statistical summary values 
(including average, minimum, maximum, or standard deviation) for selected PI points, and 
can be updated automatically at a preset frequency. 

In addition to PI data, PI Values also supports relational and web service data sources. To use 
a dataset, select the dataset column that contains the values you want to display in PI Values. 
Columns configured for the web part that do not have a matching column (by name) in the 
dataset show blank values in those columns for the dataset rows. 

 

PI Values Data Display 

These standard PI summary calculations are supported in PI Values web parts: 

Calculation Definition 

Average The average of all events that take place during a given time 
period. 

IntervalMinimum Minimum event value encountered during a given period. 

IntervalMaximum Maximum event value encountered during a given period. 

Range Difference between the minimum and maximum values 
returned for a given period. 

StdDev 
(Standard Deviation) 

Time weighted Standard Deviation of all event values during 
a given period. 

Total Total over the given time range. 

PercentGood The percentage of good events during a given period. 

IntervalMinimumTime The time the Minimum event value occurred within a given 
period. 

IntervalMaximumTime The time the Maximum event value occurred within a given 
period. 

StartOfIntervalTime The start time for a given period. 

Chapter 16 

The PI Values Web Part 
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Calculation Definition 

EndOfIntervalTime The end time for a given period. 

You can also use a PI Values web part to display data from a PI Calculation dataset. Datasets 
provide the means to present more complex computations in any desired combination. For 
example, you can use PI Data Services to create a dataset that displays time, value and 
running or moving average columns to track a PI point and its average value over a selected 
time range.  

 

Configure PI Values Web Parts 

You can configure a PI Values web part using the web part tool pane and standard tool parts 
including Time Range (page 18), Selected Data (page 19), Table Columns (page 27), Filter 
Values (page 30), Appearance, Layout and Advanced. 

Note: The default RtSnapShot table configuration used for PI Values web parts applies 
Trend behavior to the Dataset column; apply a different table configuration to set a 
different behavior. 

PI Values tools also include an additional tool part that allows you to define Summary 
Parameters for calculations. 

 

Summary Parameters 

The Summary Parameters determine how summary data is calculated for PI tags in the 
Selected Data list. 

Note: If some values received over the Calculation Interval are bad, summary values are 
divided by the fraction of the interval for which there were good values.  

Use Web Part Time Range 
Check to indicate that the web part time range should be used to determine the calculation 
interval.  

The check box is cleared by default. When the check box is selected the Calculation Interval, 
Sync Time and Interval Type fields are disabled. 

Calculation Interval 
The length of time used to sample the PI events being summarized, expressed as a numeric 
value followed by a PI time interval or abbreviation. Fractional values are allowed when the 
interval is hours, minutes, or seconds (for example 90m or 1.5 hours). The default value is 
60m. 
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Interval Type  
Specify the type of interval period used to collect data for the summary calculation: 

• Choose Fixed to use data collected during the most recent closed interval, based on clock 
time. The last full interval completed prior to the End time of the table is used as the 
calculation period.  

• Choose Running to use data collected during the current open interval, based on clock 
time. The fractional period following the last full interval completed is used as the 
calculation period. 

• Choose Moving to use data collected during the most recent closed interval, based on the 
End time of the table. The full interval defined by the End time minus the Calculation 
Interval is used as the calculation period.  

Sync Time 
A time on the twenty-four hour clock synchronized with the Calculation Interval to determine 
calculation times. Sync Time is required for Fixed and Running summary calculations.  

For example, if a Calculation Interval is one hour and the Sync Time is 00:00:00, fixed 
summaries are calculated every hour on the hour (or upon the first update that occurs 
thereafter) based on all events occurring from the beginning of the previous hour to the 
beginning of the current hour.  

Running summaries are calculated at each update interval, and show the summary of all 
events from the beginning of the current hour to the current time.  

For a Sync Time of 00:30:00, fixed calculations occur every hour on the half hour, while 
running summaries are calculated at each update interval for all events occurring since the 
last half hour.  

Sync Time is ignored for moving summaries, which are recalculated at each update interval. 
For a Calculation Interval of one hour, the summary of all events occurring between one hour 
ago and the current time is displayed.  

Conversion Factor 
Enter the time unit of flow for the source tag used in a Total calculation. By default, the PI 
server assumes source tag values are expressed in units per day. If a tag is measured at a rate 
other than units per day, a conversion factor must be supplied to convert input values and 
calculate totals correctly.  

For example, apply a factor of 1h to indicate the source tag is measured in units per hour, or 
15m to indicate a rate of flow in units per quarter hour. Conversion factors may be expressed 
in day d, hour h, minute m, and second s increments.  

Note: A conversion factor is not required for other calculation modes.  

Display Summary Settings 
Displays start and end times for the current summary interval in the table footer if enabled, 
with summary columns included in the table. 
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PI Values Connections 

The PI Values web part supports SharePoint connections (page 33) to other PI WebParts: 

As a Consumer 
• Accepts time range changes from the PI TimeRange web part, or any other web part that 

provides Start and End timestamps. 

• Accepts PI tag data sources from any other web part and adds them to the list of 
configured data. 

• Accepts querystring parameters to set initial values. 

As a Provider 
• Column values can be sent to consuming web parts as parameters when a row is selected.  

• Provides a column value from a selected row from a data column as a filter value, 
through an ITransformableFilterValues connection. The column value can be consumed, 
for example, by the Excel Web Access web part and used to resolve a PI DataLink 
function in a spreadsheet cell. 
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The PI XYPlot web part compares two or more selected data items against each other in a 
scatter plot. For example, you can use PI XYPlot to measure the efficiency or quality of a 
process, by comparing sampled data to well-known or validated data. 

PI XYPlot includes an X Tag selection mechanism that allows you to choose between 
interpolated and recorded values, and the ability to show a linear correlation line and 
correlation coefficient.  

 
PI XYPlot web parts can plot data from relational and web service datasets, as well as 
recorded or interpolated attribute and tag values and calculated summaries. Tools enable you 
to zoom and scroll the display and view cursors and tooltips.  

Note: This web part is rendered in Scalable Vector Graphic (SVG) format and requires 
the Adobe SVG Viewer.  

 

Chapter 17 

The PI XYPlot Web Part 
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Configure PI XYPlot Web Parts 

You can configure a PI XYPlot web part using the web part tool pane and standard tool parts 
including Time Range (page 18), Selected Data (page 19), Appearance, Layout and 
Advanced.  

PI XYPlot tools also include an additional XYPlot Properties tool part that allows you to 
customize the formatting of a plot. 

Data Retrieval Properties 

These properties determine how data items are acquired and paired for plotting.  

Note: These settings apply only to the currently-selected data item. Choose each item in 
the Selected Data list and apply settings individually to customize the entire web 
part display.  

The Data Retrieval tool part includes these properties: 

X Tag 
Choose a data item to use as the X source for the plot. The X axis scale for the plot is based 
on this item.  

X Query Type 
Choose an acquisition method for the X Tag data item query: 

• Recorded data are actual recorded values from the PI server or selected dataset column. 

• Interpolated data are points taken from regular time intervals by sampling a full dataset. 
Only PI tag data can be interpolated. If you choose to interpolate X tag data, you can also 
enter a sample interval to govern the rate of interpolation.  

Note: This field is disabled if the X Tag item is not selected in the Selected Data list.  

Y Query Type 
Choose an acquisition method for the Y tag data item query:  

• Recorded data are values from the PI server or selected dataset. Y values are indexed to 
correspond with X values, and may be time-shifted. 

Note: PI XYPlot supports columns from datasets without timestamps only if the 
Recorded retrieval method is used.  

• Interpolated data are points taken from regular time intervals by sampling a full dataset. 
Only PI tag data can be interpolated. Y values are indexed to correspond with X values, 
and may be time-shifted. 
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• Synchronized data queries the Y data array using the time array returned with X data. 
Provided the Y data is interpolated over the same time range, a value should be 
determined and paired with each respective X event.  

• Matched queries can be used in cases where interpolated data are not desirable. If X and 
Y data have matching timestamps over the desired interval, matching effectively pairs X 
and Y values by timestamp. Similarly, if X and Y timestamps are rough, but not 
necessarily exact matches, then it may be appropriate to match Y events to X events 
using the Match or Previous or Match or Next options. 

Note: This field is disabled if the X Tag item is currently selected in the Selected 
Data list. Select a Y Tag item to choose the Y Query Type. 

Use for all Y tags 
Choose to apply the Y Query Type to all Y tags used in the plot. 

Note: PI Calculation, relational and web service dataset columns cannot be interpolated. 
Non-PI items set to Interpolated are automatically reset to Recorded.  

 

Plot Time Properties 

For the Y Query Types Synchronize and Match, the Plot Time is automatically made the 
same as the Plot Time of the X Tag. For Recorded query types, the Sample Interval is 
disabled. 

Note: These settings apply only to the currently-selected data item. Choose each item in 
the Selected Data list and apply settings individually to customize the entire web 
part display.  

• Enter the Start Time for the selected data item. The default is *-2h, or two hours prior to 
the present time. 

• Enter the End Time for the selected data item. The default is *, or the current time. 

• Enter a Sample Interval if the data is interpolated.  
 

Value Scale Properties 

Each PI XYPlot web part has an X scale and one or more Y scales. Value Scale properties 
configure the appearance of the Y scale for each plotted Y data item:  

Note: These settings apply only to the currently-selected data item. Choose each item in 
the Selected Data list and apply settings individually to customize the entire web 
part display.  

The Value Scale tool part includes these properties: 
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Multiple Y Values Scales 
Check Multiple Y Value Scales to display separate scales along the vertical values axis for 
each data item plotted along the Y axis. When cleared, the Y axis is scaled to fit all values 
data for data items identified as Y tags. 

Number Format 
A number format (page 100) is applied to scale, legend, tooltip and cursor values per each 
additional Y Values Scale, if enabled, in PI XYPlot. Choose each item in the Selected Data 
list and apply settings individually. Choose each item in the Selected Data list and apply 
settings individually. 

When the Database format is selected for PI tag data, the number of decimal places used for 
floating point numbers is determined by the DisplayDigits (page 101) attribute. This format is 
disabled for non-PI data, which uses the General number format by default. 

XYPlot Scale Range 
Minimum Scale and Maximum Scale properties set the range of additional Y Value scales, 
if enabled, for each Selected Data item. The following options provide different means to 
determine minimum and maximum scale values: 

Autorange  
Autorange calibrates the scale automatically using actual data values whenever updates are 
received. The calibration depends on the Multiple Y Value Scales setting: 

• If Multiple Value Scales is selected, each trace has its own values scale. The lowest and 
highest values for each trace determine the minimum and maximum values for the 
corresponding scale.   

• If Multiple Value Scales is not selected, a single scale is used for all traces. The lowest 
minimum and highest maximum values currently plotted for all traces are used as 
minimum and maximum values for the combined scale. 

Database 
For floating point or integer PI point values based on a PI Point, or an AF Attribute that refers 
to a PI Point, Database assigns the Zero attribute as the minimum scale value, and the Zero 
attribute plus the Span attribute as the maximum scale value. For digital state tags, the 
minimum is always 0, and the maximum is always one less than the total number of states. 
This option is disabled for dataset columns and other non-PI data. 

Custom  
Custom applies user-specified minimum and maximum scale values entered in the 
accompanying text boxes.  
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Display Properties 

Use the Legend and Options groups to set visual display options.  

Legend Properties 
Legend properties apply to all selected X and Y data items, except as noted: 

• Legend information (with the exception of Description) for the X Tag is shown below the 
plot.  

• Legend information (with the exception of Description) for the Y Tags is shown to the 
right of the plot.  

• When the Description box is checked in the Legend group, all Descriptions for all traces 
are shown below the plot, and below any other Legend information for the X Tag. 

Select check boxes in the Legend area to include specific information in the legend. All 
options except for Correlation Coefficient are enabled by default:  

• Choose Dataset Name to display the dataset or attribute name.  

• Choose Description to display the dataset description. 

• Choose Last Value to display the most recent value of the plotted dataset. For digital and 
string tags, a string value is shown. 

• Choose Units to display engineering units for PI tags. 

• Choose Correlation Coefficient to calculate and display a correlation coefficient for Y 
scale data items.  

Options Properties 
Use the Options area to specify optional visual elements for the entire plot. All items are 
enabled by default with the exception of Title: 

• Choose Title to display the title that appears in the adjacent text box. 

• Choose Scales Inside Axis to display vertical scales to the right of the Vertical Axis, 
inside the plot area.  

• Choose Show Gridlines to display vertical and horizontal gridlines. 

• Choose Linear Correlation Lines to display a linear correlation line through plot points.  

• Choose Connecting Lines to display connecting lines between plot points in the order 
they are plotted, as opposed to a scatter plot with no lines. 

• Choose Show Value Attributes to display value attribute icons to indicate flagged data 
points. 
ο Substituted  indicates that the value has been changed from its original value. This 

value is set only by the PI Archive Subsystem when an existing value is changed. 
ο Annotated  indicates that there is a comment about a value.  
ο Questionable  indicates that there is some reason to doubt the accuracy of the value. 
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When more than one value attribute applies, the highest priority attribute is rendered. 
Attribute priorities from highest to lowest are: Error, Questionable, Annotated, and 
Substituted.   

 

XYPlot Formatting Properties 

If specific formats are defined for your site under PI Data Services, you can select and apply 
one to PI XYPlot web parts:  

• Select and apply a named format from the Trend Formatting list. The default value is 
System Default. 

• If you are a PI WebParts administrator, you can use click the Configure  button to 
edit or add new formats. A configuration page opens in a new browser window with 
specific formatting tools.  

See the PI WebParts Administrator Guide for more information about defining named 
formats. 

 

PI XYPlot Connections 

The PI XYPlot web part supports SharePoint connections (page 33) to other PI WebParts:  

As a Consumer 
• Accepts time range changes from the PI TimeRange web part, or any other web part that 

provides Start and End timestamps. 

• Accepts PI tag data items from any other web part and adds them as additional Y plot 
tags. The X Tag may not be changed through a web part connection. 

• Accepts querystring parameters to set initial values. 
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The following appendices describe time format, data source, and data display details common 
to PI WebParts.  

 

PI Time 

PI Time abbreviations and PI Time expressions allow you to specify times and time ranges 
for data using constants, variables, and short expressions. 

PI Time Abbreviations 
An interval is a unit of time that can be used in time entries. Intervals that support fractional 
values are listed below. For intervals where the Fractions column indicates No, fractional 
amounts cannot be used in time strings. 

Name Short name Plural name Member names Fractions 

second s seconds no yes 

minute m minutes no yes 

hour h hours no yes 

day d days no no 

month mo months yes (for example, December) no 

year y years no no 

week w weeks no no 

weekday wd weekdays yes (for example, Tuesday) no 

yearday yd yeardays no no 

You can spell out month and weekday names, or enter the first three letters (for example, 
Dec, Tue).  

PI Times can also be expressed using certain constants: 

Constant Result 

* The current time. 

Today or t 12:00 am of the current day. 

Yesterday or y 12:00 am of the previous day. 

Sunday or sun 00:00:00 (midnight) on the most recent past Sunday (in reference 
to the PI Server). 

 

Appendix A 

Supplementary Information 
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PI Time Expressions 
PI allows three types of time expressions: relative time, combined time, and absolute time. 
These time expression types are defined in the following table. 

Expression Description Examples 

Relative Time  Relative time expressions specify a number of days, 
hours, minutes, or seconds with either a leading plus 
sign or a leading minus sign. 
In the absence of a reference time (such as * or an 
absolute time) in either the start or end time strings, the 
end time is calculated relative to current clock time and 
the start time is calculated relative to the end time. 

+1d 
-24h 
-3m 
+24s 

 

Combined 
Time  

A combined time expression is a specific reference time 
followed by a relative time expression. 

*+8h 
18-dec-02 -
3m 
t+32s 

Absolute Time An absolute time expression is any time expression that 
is neither a relative nor a combined time expression.  

* 
14-Dec-97 
11-Nov-96 
2:00:00.000
1 
t 
y 

When using PI times, follow these guidelines: 

• Use absolute or combined time expressions. Avoid using relative time expressions. 
Multiple relative time expressions in a time range may cause an incorrect start time or an 
error message, depending on the context of the expression. 

• Relative and combined time expressions contain only a single operator: either a single 
plus sign (+) or a single minus sign (-). Additional operators can lead to unpredictable 
results. For example, the following are not valid time expressions: 
*+1d+4h 
T-1d+12h 

• The name or short name for an interval used to denote PI time is not case-sensitive. 
 

PI Data Type Support 

Values from PI tags and AF Attribute data sources may appear differently in PI WebParts that 
support them. The following table describes web part support for PI data types and display 
variances: 
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Data Type Support Display Notes 

Digital (defined states) PI Gauge 
PI Graphic 
PI TimeSeries 
PI Trend 
PI Values 
PI XYPlot 

In PI Gauge, PI Trend and PI XYPlot, the digital 
integer code is used to plot the data and scale 
values, and the digital state string value appears in 
the tooltip and legend. They may be plotted as 
Stepped trends in PI Trend. 
In PI TimeSeries and PI Values, the digital state 
string value is used in the table. 

Int (16 and 32) 
Float (16, 32 and 64) 

PI Gauge 
PI Graphic 
PI TimeSeries 
PI Trend 
PI Values 
PI XYPlot 

Scale values appear in corresponding number 
format, and may be plotted as Stepped or 
Continuous in PI Trend. 

String (text) PI Graphic 
PI TimeSeries 
PI Trend 
PI Values 

Appear in text format. 

Timestamp PI Gauge 
PI Graphic 
PI TimeSeries 
PI Trend 
PI Values 
PI XYPlot 

Timestamps are displayed using default short date 
and time formats according to SharePoint locale 
settings. 

Blob Not supported  
  

Other Supported Data Types 

PI server data is recorded in time series format; a date or timestamp is associated with every 
data point value. Data from relational sources or an ERP system may or may not include 
corresponding timestamps for each data point value.  

For example, a relational database column might store temperature values. If this column is 
joined to a timestamp column in a dataset query, the columns form a time series, and you can 
plot the trend of temperatures over time. Without the link between the columns however, the 
temperature value column is simply a set of numbers. Relational columns could also store 
lists of customers, addresses and other information which does not correspond to time values.   

Non-PI datasets that form a time series can be used with PI Gauge, PI TimeSeries, PI Trend, 
PI Values and PI XYPlot. If the dataset has parameters or placeholders for Start and End 
times, you can use the PI TimeRange or the web part's Time Range tools to resolve these 
parameter values. A time range limits the dataset query to display data only for a particular 
time interval. 

If non-PI data does not represent a time series, dataset column values are treated simply as 
point values. Time Range settings and data updates directed to the web part do not affect the 
data display. Numeric points are plotted as straight lines across trend graphs and null values 
are displayed as a No Data condition.  
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The following .NET data types from relational or web services sources are supported: 

 Boolean  
 Byte  
 Char  
 DateTime 
 Decimal  

 Double (floating point) 
 Int16  
 Int32  
 Int64  
 SByte  

 Single (floating point) 
 String  
 UInt16  
 UInt32  
 UInt64  

The following .NET data types are not supported: 

• Blob 

• TimeSpan 
 

Number Formats 

PI WebParts uses standard number formats. When the Database number format is in effect, 
the presentation of a formatted value depends on display digits (page 101) attributes and 
whether it appears as a point value or scale value, as described in the table below:  

Format Point Behavior Scale Behavior 

General (default) Displays all significant digits as space 
allows, switching to scientific notation 
at 1e+7 and 1e-5.  
Precision for scientific notation is 6 
digits (0.00000E+00).  

Displays all significant digits 
as space allows, switching to 
scientific notation at 1e+7 and 
1e-5.  
Precision for scientific 
notation is 3 digits 
(0.00E+00). 

Database (tag attribute 
displaydigits < 0) 

Displays a number of significant digits (for example, -3 displays up to 3 
significant digits). 
The algorithm attempts to produce abs(displaydigits) digits first in 
decimal format, then in exponential format. 

Database (tag attribute 
displaydigits >= 0) 

Displays significant digits and a number of decimal places specified by 
the display digits.  
For example, displaydigits 2 results in a format of "0.00". A 
displaydigits value of 0 does not include a decimal symbol. 

Scientific Uses 6-digit precision (0.00000E+00). 
For example: 1234567 displays the 
same; 12345678 displays as 
1.23457e7. 

Use 3-digit precision 
(0.00E+00). 

0.00 (and related 
explicit formats) 

Applies the user-specified format, which may result in values displayed 
as 0. Pound (#) characters show a digit if there is one while zero (0) 
prints a zero even if there is no data value. 
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Display Digits 
Integer and floating point data are displayed using default number formats (page 100), with 
decimal and group separator characters specified by the SharePoint locale (page 7). Non-PI 
data is displayed as returned from the data source with formats specified by the web part. 

For PI data, the number of decimal places displayed for floating point tags is determined by 
the DisplayDigits attribute of the tag when the Database number format is applied (the 
default). Negative displaydigits values indicate the number of significant digits to display. 
Positive values indicate the number of decimal places to show. 

For example, the following values would appear depending on the DisplayDigits setting: 

-5 DisplayDigits Setting +5 DisplayDigits Setting 

 .0123456, shows 1.2346E-02 
 .123456, shows .12346 
 1.23456, shows 1.2346 
 12.3456, shows 12.346 
 123.456, shows 123.46 
 1234.56, shows 1,234.6 
 123456., shows 1.2346E+05 
 1234567, shows 1.2346E+06 

 .0123456, shows .01235 
 .123456, shows .12346 
 1.23456, shows 1.23456 
 12.3456, shows 12.34560 
 123.456, shows 123.45600 
 1234.56, shows 1,234.56000 
 12345.6, shows 12345.60000 
 123456, shows 123456.00000 
 1234567 shows 1234567.00000 

  

URL Querystring Encoding 

All querystring parameter values must be URL-encoded to prevent ambiguity when special or 
invalid characters are included. The following is a list of special characters and their URL 
encoded substitutes. 

Character Substitute Character Substitute 

  ;   %3B  >  %3E 

  ?   %3F  ~  %7E 

  /   %2F   %   %25 

  :   %3A   @   %40 

  #   %23   "   %22 

  &   %24   ^   %5E 

  =   %3D   `   %60 

  +   %2B   [   %5B 

  $   %26   ]   %5D 

  ,   %2C   {   %7B 

  <SPACE>   %20   }   %7D 

  %    %25   |   %7C 

  <     %3C   
  



Supplementary Information 

  
102 

   
 

Connection Parameters 

The following table summarizes the connections available between individual PI web parts 
and the parameters each web part may consume and provide. Note that all web parts can 
consume querystring parameters and that all parameters available to a provider web part may 
be consumed, even if they are not displayed.  

 
Consumes Provides 

PI ActiveView Start Time 
End Time 
Selected File 
Override Default Context Path 

 

PI BatchTable Start Time 
End Time 
Status 
Server 
Batch ID 
Product 
Recipe 
Procedure 
Unit Name 
Unit Heading 

Start Time 
End Time 
Unique ID 
Batch ID 
Unit Name 
Duration 
Server 
Unit Path 
Batch Type 
Status 
Unit Heading 
Procedure 
Recipe 
Product 

PI Gauge Start Time 
End Time 
Selected Data 
Context Path 
Maximum Scale 
Minimum Scale 
Parameters/Placeholders 

 

PI Graphic Start Time 
End Time 
Selected File 
XSL Transform File 
Override Default Context Path 

Start Time 
End Time 
Symbol Name 
Data Source 

PI Messenger Active Directory Groups 
Parameters/Placeholders 

 

PI Table Start Time 
End Time 
Context Path 
Parameters/Placeholders 

Column Values 

PI TimeRange Start Time 
End Time 

Start Time 
End Time 
Current Time 
Time Range 
Is Updating flag 
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Consumes Provides 

PI TimeSeries Start Time 
End Time 
Selected Data 
Context Path 
Parameters/Placeholders 

Column Values 

PI TreeView Query Date Element Name 
Element Path 
Element Relative Path 
PI Tag Lists 
AF Attributes 

PI Trend Start Time 
End Time 
Selected Data 
Context Path 
Parameters/Placeholders 

 

PI Values Start Time 
End Time 
Selected Data 
Context Path 
Parameters/Placeholders 

Column Values 

PI XYPlot Start Time 
End Time 
Selected Data 
Context Path 
Parameters/Placeholders 

 

 

SharePoint Connection Types 

PI WebParts use standard SharePoint interfaces to establish connections, allowing a wide 
range of potential providers and consumers.  

The choices available in a web part's Connections menu depend on the types of web parts you 
are connecting: 

• Parameter-based IParametersOutProvider and IParametersOutConsumer connections 
exchange data on the client or server side. They do not require a page reload for each 
update unless the page is set to Design mode.  

• Row-based IRowProvider and IRowConsumer connections exchange data through a 
server-side connection only. Row values require a page reload for each update.  

• Generally speaking, if both Parameter and Row connections are available, Parameter 
connections are preferable because they do not require the web part to post back to the 
server, thereby improving response time. 

• ITransformableFilterValues connections pass one or more related values from a provider 
to a consumer web part, which uses the values to filter data results. 
ITransformableFilterValues connections are used most commonly as parameters sent to 
an Excel Web Access (EWA) web part. 

The types of connections available to each web part are summarized below: 
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IRow IParametersOut  

Web Part Provider Consumer Provider Consumer ITransformableFilterValues 

PI ActiveView  X  X  

PI Gauge  X  X  

PI Graphic X X X X  

PI Messenger  X  X  

PI Table X X X X X 

PI TimeRange X  X  X 

PI TimeSeries X X X X X 

PI TreeView X  X  X 

PI Trend  X  X  

PI Values X X X X X 

PI XYPlot  X  X  

 
 



 

  
PI Web Parts 2010 User Guide  105 

 

You can read complete information about technical support options, and access all of the 
following resources at the OSIsoft Technical Support Web site: 

http://techsupport.osisoft.com 

Before You Call or Write for Help 

When you contact OSIsoft Technical Support, please provide: 

• Product name, version, and/or build numbers 

• Computer platform (CPU type, operating system, and version number) 

• The time that the difficulty started 

• The log files at that time 

Help Desk and Telephone Support 

You can contact OSIsoft Technical Support 24 hours a day. Use the numbers in the table 
below to find the most appropriate number for your area. Dialing any of these numbers will 
route your call into our global support queue to be answered by engineers stationed around 
the world. 

Office Location Access Number Local Language Options 

San Leandro, CA, USA 1 510 297 5828 English 

Philadelphia, PA, USA 1 215 606 0705 English 

Johnson City, TN, USA 1 423 610 3800 English 

Montreal, QC, Canada 1 514 493 0663 English, French 

Sao Paulo, Brazil 55 11 3053 5040 English, Portuguese 

Frankfurt, Germany 49 6047 989 333 English, German 

Manama, Bahrain 973 1758 4429 English, Arabic 

Singapore 65 6391 1811 
86 021 2327 8686 

English, Mandarin 
Mandarin 

Perth, WA, Australia 61 8 9282 9220 English 

Appendix B 

Technical Support and Resources 
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Support may be provided in languages other than English in certain centers (listed above) 
based on availability of attendants. If you select a local language option, we will make best 
efforts to connect you with an available Technical Support Engineer (TSE) with that language 
skill. If no local language TSE is available to assist you, you will be routed to the first 
available attendant. 

If all available TSEs are busy assisting other customers when you call, you will be prompted 
to remain on the line to wait for the next available TSE or else leave a voicemail message. If 
you choose to leave a message, you will not lose your place in the queue. Your voicemail will 
be treated as a regular phone call and will be directed to the first TSE who becomes available. 

If you are calling about an ongoing case, be sure to reference your case number when you call 
so we can connect you to the engineer currently assigned to your case. If that engineer is not 
available, another engineer will attempt to assist you.  

Search Support 

From the OSIsoft Technical Support Web site, click Search Support. 

Quickly and easily search the OSIsoft Technical Support Web site's support solutions, 
documentation, and support bulletins using the advanced MS SharePoint search engine. 

E-Mail–Based Technical Support 

techsupport@osisoft.com 

When contacting OSIsoft Technical Support by e-mail, it is helpful to send the following 
information:  

• Description of issue: Short description of issue, symptoms, informational or error 
messages, history of issue.  

• Log files: See the product documentation for information on obtaining logs pertinent to 
the situation. 

Online Technical Support 

From the OSIsoft Technical Support Web site, click My Support > My Calls. 

Using OSIsoft's Online Technical Support, you can:  

• Enter a new call directly into OSIsoft's database (monitored 24 hours a day)  

• View or edit existing OSIsoft calls that you entered  

• View any of the calls entered by your organization or site, if enabled  

• See your licensed software and dates of your Service Reliance Program agreements 
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Remote Access  

From the OSIsoft Technical Support Web site, click Contact Us > Remote Support Options. 

OSIsoft Support Engineers may remotely access your server in order to provide hands-on 
troubleshooting and assistance. See the Remote Support Options page for details on the 
various methods you can use.  

On-Site Service  

From the OSIsoft Technical Support Web site, click Contact Us > On-site Field Service 
Visit. 

OSIsoft provides on-site service for a fee. Visit our On-site Field Service Visit page for more 
information. 

Knowledge Center 

From the OSIsoft Technical Support Web site, click Knowledge Center. 

The Knowledge Center provides a searchable library of documentation and technical data, as 
well as a special collection of resources for system managers. For these options, click 
Knowledge Center on the Technical Support Web site. 

• The Search Support feature allows you to search Support Solutions, Bulletins, Support 
Pages, Known Issues, Enhancements, and Documentation (including user manuals, 
release notes, and white papers). 

• System Manager Resources include tools and instructions that help you manage archive 
sizing, backup scripts, daily health checks, daylight saving time configuration, PI Server 
security, PI System sizing and configuration, PI trusts for interface nodes, and more. 

Upgrades 

From the OSIsoft Technical Support Web site, click Contact Us > Obtaining Upgrades. 

You are eligible to download or order any available version of a product for which you have 
an active Service Reliance Program (SRP), formerly known as Tech Support Agreement 
(TSA). To verify or change your SRP status, contact your Sales Representative or Technical 
Support (http://techsupport.osisoft.com/) for assistance. 

 

 
 

http://techsupport.osisoft.com/�
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